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Collaborating with a Team

^/[ost architecfure projects involve multiple people working together at any given time. It is

common in design for many people to work collaboratively to meet deadlines and create a set of

desisn documents. Revit hás tools that allow for a collaboratíve design and dociïm-entation

rocess while giving multiple people simultaneous access to the same file. This urdque function-

ality is known as worksharing.

IN THIS CHAPTER/ YOUTL LEARN TO

• Understand key worksharing concepts

• Enable worksharing on your project

• Organize worksets in your model

• M^anage workfiow with worksharing

• Understand element ownership in worksets

• Collaborate in the cloud

Understanding Worksharing Basics
Worksharing refers to the use of worksets to divide a model for the purpose of sharing project work

among multiple people. A workset is an assigned group of building elements that can be used to

manage project responsibilities, Typical worksets might be Building SheU or Core or Interiors. By

associating various building elements with worksets/ the design team is given the abiliiy to

subdivide the model to retain additional control over element ownership. Using worksets/

several people can collaborate and work within the same file without fear that their decisions

will conflict directly with their teammates. By default, worksharmg is not enabled when you

start a project because it is assumed you are in a single-user environment.

Worksharing occurs when worksets are enabled and a project file is saved as a central file

located on a network drive or in the cloud. This central file becomes the reposítory where ali fhe

design team's work is saved. Team members then create local copies of the central file on their

own workstations in whlch they will work as usual. The local copies of the model are individual

versions of the file connected to the central file (Figure 5.1).



178 | CHAPTER 5 COLLABORATING WITH A TEAM ENABLING WORKSHARING ON YOUR PROJECT | 179

FIGURE 5.1
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The only information that flows instantly befrween the local copies and the central filg a|
permissions. As you work within the model when worksharing is enabled/ edits to model

elements or settings are not dynamically transferred among the project team members.

would significantly decrease computer performance and would be distracting

to see the model constantly changing on the screen. Instead/ model updates are published

central fíle and pulled from the central file to your file when you synchronize with the cenl

trai model.

Even though worksets are established to break up a model into manageable chunks, peá

sions for a worksharing-enabled project are managed at the element levei. This means yoi

have a worksharing-enabled project with only one workset but stül have multiple users inl

file. A project file is essentially a database. As you are creating/ selecting/ and modifying

withín the model/ you are automatically obtaining permission to edít elements from the cí

database. Once permission to modify an element is granted/ no one else can make changes

element until the changes are reconciled with the central file. This occurs when you use th|

Synchronize With Central (SWC) command on the Collaborate tab to save changes youha^

made back to the central file. It also simultaneously updates your local file with any otherj

cfoanges that have been published to the central file by other team members.

THE LlBRARY WORKSHARING ANALOGY

Another way to understand worksets and how they relate to element permissions is to thi^

workset as a shelf of books in a library and of the model eïements as individual books on t^á

If you are working on a research paper about beavers, you can go to the Ïibrary and do onç'j

things: check out the entire shelf of books about animais or check out the book about

Checking out an entire shelf of books within a certaín category is the same as making at

workset ediÈable—no one else can do their animal research paper because you have ali the'

books. You have become the owner of that workset, and there can be only one owner per woj

As an alternative, you would likely borrow only fche book or books on beavers só that youl

stydents could access other animal books to complete their own papers. In this analogy, yç

become an element borrower, and there can be many borrowers within each workset. Of course, the

teacher probably made a mistake if she assigned two students to complete a research paper on

the same animal. This mistake may aJ.so hold true when your team is working in Revit, The same

model element cannot be edited simultaneously by more than one person. After ali, you probably

should not be working on the same model área as your teammate anyway, right?

The actual use of worksets can vary greatiy from project to project. Quite frankly, creatmg

^ore worksets beyond the defaults is technically not necessary; however, you can use worksets

to take advantage of other benefíts:

• Use worksets to contrai the visibility of groupings of building components, such as

building skin/ core, interior walls/ and só on, without the need to use temporary view

settings or control visibility manually,

• dose worksets as needed to remove those parts of your project from active memory/ thus

improving performance.

• Use workset ownership to prevent others from editing a part of the project you are

currently designing.

Enabling Worksharing on Your Project
The worksharing feature can be enabled in any Revit project file. You can begin worksharmg/

create and remove worksets, or move elements between worksets duríng any stage of the project.

WORKSHARING IN THE PROJECT PROCESS

When the team hás chosen to enable the worksharing feature, make sure everyone is aware of the

change to the file and that it is planneá within the project process.

To follow along with the text in this chapter/ you can downl.oad the sample buildmg project

filefrom thisbook's web page atwww.w1ley.com/go/mastenngrev-it2020. One version of the

project does not have worksets, whereas the other hás retained worksets but is not confígured for

worksharing. Open the file c05-Sample-Bu1lch'ng_Start. rvt and switchto the Collaborate fab

m the ribbon. Figure 5.2 shows the worksharing tools.

ïURE 5.2

'Collaboratetab
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You can initiate worksharing by dicking the Collaborate button. Selecting this tool ori^. 1

Collaborate díalog box/ alerting you that you are about to enable collaboration for your n^,

(Figure 5.3). You can choose to collaborate within your network or using the cloud. Both nr^:!

allow you to enable worksets. Por those who have utilízed previous versions of Revit/ vnn /,.

still mvoke worksharing by clicking Worksets; however/ you are limited to a worksharins

workflow withín your network. To begin managing your worksets regardless of havin}

to workshare within your network or in fhe cloud, @elect the Worksets button in the Manas

Collaboration panei. Two worksets are automaticaUy created within your project: Shared Lê

And Grids/ to which any existmg leveis and grids in your project will be assigned; and Woric^
to which ali other building elements wíll be assigned. You can rename these worksets; howf

we recommend not renaming Worksetl because this is the default system workset that can n^'|

be deleted—even if it hás been renamed. You will read about an alternative way to use Woi

in the section Organizing Worksets later in this chapter.

Dsen|

FIGURE 5.3
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Click OK to confírm that you want to enable worksharing. Depending on the size oí your

model ana your processar speed, tHs process can take a few minutes to complete. Once it is

done, the Worksets dialog box opens (Figure 5.4).

In fhe Worksets dialog box/ you can create as many user-defined worksets as necessary; we

offer some tips in the section "Organizéng Worksets" later in this chapter. By default, when a new

workset is created/ Ít does not contam any model elements or components. You can add model

elements to worksets as you build them or reassign existmg elements to worksets. The Worksets

dialog box also lets you take and relinquish permissions over existing worksets. First/ you should

understand the dífferent types of worksets íllustrated by the optíons in the Show área at the

bottom of the Worksets dialog box, shown in Figure 5.4.
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You can also specify default settings for opening the project file (shown under OpenWorkset
Default). We wüfdiscuss opening a file in the section "Creating a Local File" later in this chapter/

but we recommend settmg this option to Specify for most project scenarios. This will always

prompt your team members with the Worksets dialog box when a local file Ís opened. Click OK

to exit the File Save Optíons dialog box,
Back in the Save As dialog box/ choose a network location that everyone on the team hás

access to for your central file. Be sure that when you are naming your new central file/ you

choose a new name. We recommend you do not save over the existing Revit project file. There are

two reasons for this. First, this workflow automatically gives you a backup of your file as it

existed before worksharing was enabled. Seconá/ saving over an open Revit file can sometimes

cause corruption/ even if itis the same model. It is aiso a good idea to name fhe file with some

clarity that helps identify it as a central file/ such as MyProject-CentraT.. rvt.

p^s a^aÏrlativiTJeJ^^^ usmg the save As_> p^ect command fr^ the Application |
^u;m.mymdïkte.buttoninstead^^^^
As^ialog box/ díck the Options button to access the options 'shown^K^sT^ 11[ lllc 'C1V1

.^^llboxn^t_a.m.ssom^ j
ttT.,theÏiImkeep mthefoldeï history af^^ves:TheIdefaultIvZe ÍsL20luDepce^mg on;|
ti;e,!tor^e^l!abïtyon your network/ how often yourn^workïba^ u^^d^ZÏ |
oipeople.workingin the model ?emember/1^1 fflesareaÍsob"ackup7)7youu"m?uw^ j

^e,a!e &lnrteForexampIe/,iftee users are ^chronÍzingwYth ÍhTcenTml fifeeïery30
.mmufesOTerthecourseo^workday/ that might be 48 s^ befoïe thenextbackup"Bette7safe
íhan sony:Alsof the Make Thls A central Model AfterSave7heck7o;Ts^cteTJd Ïayced^. |
I^ÍSbecause_wehave activated w^^rmg in fhis file andÍtisTssumedTa^TwÏlT
makmg a central file on fhe next save.

NAMING FILES IN RBVIT

When you are working with a pro)ect team in Revit, it is Ímportant to give your varíous team mem-

bers some guidance when you name your files. We just touched on the idea of making sure you

include "Central" in your fílename só team members know they will need to make a local copy when

opening the file, but there are some other guidelines you might want to consider.

When woridngwith other disciplines, consider namingyour fíle with a âenomínator to let. the larger

team know whích file is architectural, which is structural, and só on. Also, because your office might

be working on several Revit projecÈs at one ume, you might be working in more than one version of

Revit if you're working on more than one project. Só its a good idea to include the Revit version m

your fílename só teammembers don't accidenfcally open the file with a newer version. An example

íilename might be c05-Sample-Bunding-A20-Central. rvt. "cOS-Sample^Buildmg^is the

projecï name, "A" designates the discipline as architectural, "20" is the version of Revit (2020), and

"Central"' notes it is a central file.
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Once you have entered a new name for the file, click the Save button to save the file. l^

your file is saved to the network, dose ali the open view windows. As one final step,

make sure you don't accidentaUy ref-am any rights over the objects and elements within ^g

central file, thereby prohibiting anyone from editing those elements.

To do this/ go to the Collaborate tab, find the Synchronize panei, and click the Synchronr

Witb Central button. This button is a flyout button that contains frwo commands: Synchroni.

And IVIodify Settmgs and Synchrorúze Now. You will want to use Synchronize And Modij

Settings in this case. In the Synchronize WÍth Central dialog box, shown in Figure 5.7, make

you select any available check boxes in the middle portion to relinquish ownership of ali

worksets. You can also add a comment to identify the action taken prior to this synchroniza+ir
Yes/ it might seem odd to use the Synchronize With Central command when

in the central file/ but this method is the fastest way to relinquish ali worksets and compl(

setup of the central file. Click OK to complete the synchronization.

suiei

FIGURE 5.7
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Selecting a Starting View
On the Manage tab of the ribbon, locate the Manage Project panei and click the Starting View

comm.and. With thLs comiriand, you can select any project view to be the first view displayed

when the model is opened (Figure 5.8). Because 3D views take longer to regenerate when your

?ject opens/ we recommend you select a 2D view to speed this process; you can even create a

drafting view that contains the project name and image as the starting view.
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USING AN AUTODESK® REVIT® SERVER ACCELERATOR

If your project team is distributed in various geographic locations/ an alternative to synchroniz-

ing with the central model directly over the wide área network (WAN) is to use an Autodesk®

Revit® Server Accelerator. This technology was developed by Autodesk to support extended

collaboration through the use of server technology that creates a layer of virtual central models.

The Revit Server then manages changes into a single central model without burdening the WAN

with full synchronization traffic.

Another tool that allows collaboration befrween offices withm the same model is Autodesk®

BTM 360 Design®/ which we discuss more in the "Collaborating in the Cloud'/ section later in th15

chapter. BÏM 360 Design is different from Revit Server in that Ít uses cloud technologies to pass

model changes between users, and ali that is required an Internet connection. This approach is

easier on IT departments as it requires less server support but might add security concerns il

project models need to be kept localized to an office.

Another use for the starting view is as a project bulletin board. Símply create a draftmg view

for the starting view and keep it populated with project standards/ modeling action items, and

other notes your team might need to know like upcoming deadtines.

Synchronize the central file once again/ and remember to relinquish any worksets you might

have obtained during the confíguration of the central file. From the Applícation menu/ click

Close to dose the central file.

ÜSING CAÜTION WHEN USING A CENTRAL FILE

Once you. have created a central file, there are a couple of things you cannot do. Do not open it

directly again and do not change the fiïename. Opening the file will change its attributes, and none

of your team niembers will be able to synchronize with central. If they were actively working in the

local file, their work would be lost. The same problem occurs if you change the filename—those with

a local copy wiil lose theír association to the central file, and they will not be able to save their work.
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Creating a Local File

Now that you have made a central file, you will need to create a local copy of it y

organize worksets for team collaboration and continue your design and docurneni-a+;

are severa] ways to perform this action. One option is to símply open the networL- ^i .'

central file and copy the file from the network to your desktop or anywhere on

drive. Be careful not to move íhe file—only copy it. It is also a good idea to renamp+k.c!

something that identifies itas a locai file/ such as c05-Samp-Le-Bu1'Ld1ng-Loca1.

The most predictable method for creatmg a local file is to use the functionality ii

the Open command. UsÍng any common method to open a file/ you will get to

box (Figure 5.9). Navigate to the central file, and when it is selectcd/ you will have

create a new local file at the bottom of the dialog box. Whenever you select a ceníral fíi

tihe Open dialog box/ this box is checked for you as a safety precaution again;

central file directly.

FIGURE 5.9
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The local file is created in the location specified as the default path for user files. Thisl
can be found in the application options/ under the File Locatíons settings. The default k

this setting is the My Documents folder. Tf you choose this method/ the local file will be l
appended with your Revít username. If you have already created a local file with this

you will be prompted with a warning t-he next time you attempt to create a newlocal a

the central file (Figure 5.10). You have íhe option to either overwrite the existing local cf

append a time stamp to the existing file.

FIGURE 5.10
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Before you proceed to open the file, you can change the way you ínteract with woi

you click the small arrow to the right of the Open button/ you will see a list of optionsj

in Figure 5.11.
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The default setting for opening worksharing files is Last Viewed/ but each of the available

rs is helpful to your workflow. Lefs review these settings in detail:

AH This settmg opens ali available user-created worksets.

Editable Thts setting opens only those worksets that you have previously made editable. If

did not retain ownershtp of any worksets the last time you worked on a local fíle/ none of

the user-created worksets will be opened. To retain ownership of worksets when you dose a

file/ you will be prompted with the alert shown in Figure 5.12. Choose the option to keep

ownership of elements and worksets. We do not recommend this workflow because it restricts

others on your team from working on elements for which you retain ownership.
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Last Víewed The file will be opened with the Last Viewed worksets confíguration. If you

use this option when opening a new local file for the first time/ ali worksets will be opened.

Specify We highly recommend this option because it will give you the most flexibility when
openmg a local file and is helpful with cutting down the open time for large files. When

Specify is selected/ you wiil be presented with the Worksets dialog box Ímmediately after you
click the Open button. You can then choose the worksets you would like to open or dose

before the file is loaded into memory.
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To continue your exercise/ choose the Specify option and then click the Open button

tüne any local file is opened using a method other than the Create New Local option, vnt,. .

see a warning message alerting you tbat you are opening a local file. This is simply a no^

that you have made a local copy of a central file and you will be the owner of the local fn^^
warning appears/ click Close to dismiss the warning and cortinue the fíle-(

The Worksets dialog box will be displayed if you used the Specify option to open thp fíi
this point m the exerdse, you will still have only Shared Leveis And Grids and Worksetl.h^i

the future, you will have the ability to dose any workset you may not need for editirL& n

work session. CUck OK to dose the Worksets dialog box.

THB BENEPITS OV REVIT LOCAL FlLBS

Using a worksharing environment allows you to do somethíng your IT department typu

you not to ao: work directly on your workstation s hard drive. Although working off a networ};- fíi

typically a good idea, there are several reasons why a local copy offers adâitional benefits:

• It allows more than one user ÉO make changes to the central file by editing local files and

chronizing those changes with fche central file.

• Your local copy will be more responsive than a networked local file because your access speel

your hard drive is much faster than it is across most networks.

• If anything bad happens to your network or your central file, such as file cormption, eachll

file is basically a backup that can be used to create a central file. Simply perform a Save As ool

tion and select the option to make this a new central file.

Using Worksharing Usernames
Each local file is automatically associated with your worksharing username once Ít is openec

after it is opened/ it cannot be edited by any other user. By default/ your Wirtdows login nai

used as your worksharing username. When you use the Create New Local option to open a.|

worksharing-enabled project/ the username is appended to the end of the local filename—fe

example/ c05-Sample-Bu'i'Ld1ng~Al6-Central_YourName. rvt.

It can be a good idea to adjust the naming convention for usernames to help team comm^

cation. In a smaller office/ it might not be as necessary/ but in a larger office or multi-offíce

clarifica tion of element ownership is vital. One option is to change your Revit username to

name/ last name, and phone extensior, Alternatively/ with the use of tools like Slack or insl

messaging/ including a slack handle or IM name would also aid communication. This way/.

members can quickly identify and contact you if they need you to relinquish permission ofj
element. As Autodesk tools move more to cloud technologies, it is recommended that you

coordinate any renaming of your A360 account with your larger team. Changing your usei

can lead to other issues with online tools.

To make this modification, follow these steps:

l. dose ali your open project files. You can change the usemame only when no

projects are open (you cannot change your username while it is active in open pro]6t

You will also not be allowed to change your username if you have sigi

your Autodesk ID/ in which case it will use your Autodesk ID as your username. After

you change your workset username/ you will need to create a new local file because the
old local file is associated with a different username.

2. From the Application menu, choose Options at the bottom.

3. In the Options dialog box, select the General category.

4. In the Username field/ enter a new value (Figure 5.13). Click OK to exit.
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If you have signed in to an Autodesk® 360 (A360) services account, your username will

automatically switch to your A360 username. A360 is an onlme service with Autodesk accessible

from the upper-right portion of your application window. Tf you are not signed in/ you should

see the button as a small figure with Sign In next to Ít. More information on the A360 account is
provided later in this chapter.
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Organizing Worksets
Now that you have enabled worksets and confígured your project file for workshan.

the opportunity to further organize your model into more worksets. When dividiria .,„ yot

into worksets/ it is important to think about the larger building system rather thanfn^url

its individual components. In other words/ worksets should not be used like layers-in aurl!°J

application. A good way to think about dividmg up worksets is to consider the buildh
and the number of people workmg on each of these elements, A basic breakdown ofa n^!.
components might include the following: ProN

• Exterior skin

• Core

• Interior partitions (in a larger buildmg/ by floor)

• Site

• Furniture/ fixtures/ and equipment (FF&E)

• Linked files

This breakdown mirrors some of the roles and responsibilities on the project. There nu^á

small group working on exterior slcm design and detailing/ another group working on intSi!
partitions, and a fhird working on FF&E. And for larger projects where you have fínked fiíe
(possibly from other disciplines such as mechanical/ electrical, and plumbing [MEP] or strucl
it is helpful to associate those linked files with their own worksets.

HOW MANY WORKSBTS DO YOU NKED?

Á good rule of thumb is that you should have one or two worksets for every person working oi|

project (besides Shared Leveis And Grids). On a small project wiïh two or three people, you ml

only have three or four worksets. On larger projects, you could have a dozen or more.

AIso keep in mind that once you have six to eight people working in a project, the performancl

Revit slows somewhat, not ÈO mention that you will spend a bit more time saving local fües beca|

each person actually saves twice (once to save changes to central file and another to download i

ryone else s changes). Ifyour project is Ïarge enough to warrant more than six to eightpeoplewl

ing concurrently in the model, consider dividing the moáel into multiple files, as we discus|
Appendix B, "Tips, Tricks, and Troubleshooting"

Contínuing with the Sample Building exercise file, open a local copy of the central file anc
click the Worksets button from the Collaborate tab or from the status bar. Click the New buttc

and create each of the followmg new worksets (keep the Visible In AU Views option selected
each time):

• Exterior and Structure

• Furniture

• Interiors
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have done this, you sbould see a total of five user-created worksets/ as shown in

.14. The worksets we have set up demonstrate how a typical breakdown might occur in a

^Spd of this size/ but creating/ definmg/ and assignÍng worksets is by no means limited to this

Çhpme.Depending on how you structure work in your offíce, the worksets mightbe quite

ÏÍ^rpnt. Note thatonce you complete the exercise, you will need to identify which workset you

iTlikfí to make active. The Active workset is the one where any new model elements will be

wúl.^. Youcan.make the workset active in the Worksets dialog box or with the Workset selector

Jt^e .bottom of the screen.

ip 5.14
.newworksets

Wsftets

Aris./e swbeï;

IWorksetlíNotEdstable)

NamÉ

Q Grã-/ Inatíiv? Wwkset ffaptiics

Editabkl Owner [ Gorraw^ï

SHOULD YOU KEBP WORKSETA?

Why keep Worksetl? Well, it is a great holding place when new users need to work on the Pr°Jet:t'

but they are not certain to which workset they should assign the new elements they create. Tell

them not to worry! Sünply ask them to make Worksetl their active workset. After they have fín-

ished their work, they can isolate aU the elements they have created and then assign them to the

right workset later (maybe with some oversight). You can even have a custom 3D view with only

Worksetl visible to visuaUy check whether elements are placed correctly.

As we stated previously/ one of the biggest challenges fadng teams new to Revit is under-

standing the difference between layers m a CAD application as compared to worksets These

teams typically want to try to manage worksets as they managed layers in CAD/ which can result

m worksets named Doors, Wíndows/ Walls/ and só on. Although this is effective management in

a CAD environment, you do not want to create ali of this structure for worksets. Not only is it

time-consummg/ but it does not provide any benefit.
Much like layers, the workset is a tool that the team will need to understand in arder to use it

successfully. Worksets should be structured by a team's BIM coordinator or a project manager

familiar with a BIM workflow. Ultimately/ though/ it is up to the team membérs to place elements

in the proper worksets and ensure that project standards are being followed.
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Moving Elements between Worksets

^ hi^ chaPter's exercises, you are applying worksharing to an existíng:

wjll need to assign the existing model elements to íhe worksets you have crp^ tí}ere^
way to move elements between user-defíned worksets is by using a customizp^ ^he eáa CUSfïtrnr

following exercise will walk you through moving elements fromWorksetÍto^^view1
You have established, using a subtractive method to reassign the model geomeltTvnÏWO

?ï.n J_a_smgle pefson who owns au the elements to ensure that no permissions ÍR<Ï?-S]I
when elements are beins moved between worksets. ThiR is a1sn hp<;f- ^^o .^r, sues ó8

l.

. are being moved between worksets. This is also best done with^

actiyely working on the file. If you have other users with local copies/ ask them ^ULOne l
model while you're moving elements. ^ ' """"Lu Ilotuse|

To move the elements between worksets, follow these steps:

(??ln!he c??auIt,?D v.iew so you canseethe entire model. By selecting a 3D vi<=
camiot accidentally select view-specific elements (such as elevation or Rpr+i^ew':

Ïle.cÍin,s.^nly-Ïlodelel!mentsthat canbe assigned to user-defined workseTs.1^'!!
the Visibility/Graphic Overrides dialog box and choose the Worksets tab"Cho^.^J
ali the worksets except for Worksetl (Figure 5.15), and click OK. Thi& iwiÏ1 fn^Tretcl
elements that are visible on those worksets and allow you to '/subtracf;elemer

view as you move them to the nonvisible worksets.

FIGURE 5.15
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2.
To select model elements and assign them to different worksets/ you have a few options:

• For a smaller model/ select a comfortable number of elements using the Filter tool and

then modify the Workset parameter in the Properties palette. What constitutes a

"comfortable" number of elements depends on your computer/s capabilities. As an

example, if you window-select ali the elements m the Sample Building model/ you

can click the Filter button in the ribbon and choose to keep the Furniture category

active and uncheck the remaining Ítems (Figure 5.16). Click OK. In the Properties

palette, assign these elements to the Purrúture workset.

iüRB5:16.
'^filtertoolto

l^ci&object

Íegories.

Filter x

In a worksharmg-enabled file/ the default 3D view is unique to each user participatmg ii

the model. The name of bhe view will be appended with the team member/s username;!
example/ {3D - BIM Coordinator}.
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For a larger model/ it might first be necessary to select some individual components

and move them separately. Although the process remains the same (select elements

then change the workset in fhe Properties palette)/ the selection system can vary,

Another example of moving elements by selection would be to highlight an exterior

wall and use the Tab key to select a cham of exterior walls. Those exterior walls can be

moved to the Exterior And Structure workset.

Vou can also select one or more types of elements in the model and use the Temporary

Hide/Isolate tools m the view control bar. In the exercise file/ try to locate a single

window and select it. From the view contrai bar/ click the Temporary Hide/Isolate

icon and select Isolate Category. The boundary of the 3D view will be highlighted/
Índicating a temporary view setting/ and you will see only windows. Window-select

ali the windows and then go to the Froperties palette to assign them to the Exterior

And Structure workset (Figure 5.17). Return to the Temporary HÍde/Isolate icon in

the view contrai bar and select Reset Temporary Hide/Isolate.
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FIGURE 5.17
Assign the Workset
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3. Usíng the same technique/ you can move the remainder of the model elements fo

respective worksets. When ïhe default 3D view is empty/ you w.ill know that aU ^

elements have been reassigned to new worksets.

For even easier workset managemenf and qualíty control, you can create a 3D víew n;

according to each workset In each of these views/ isolate the respective workset in Qie 'Wori

tab of the Visibitíty/Graphic Overrides dialog box. After these views are esíablished in the
project/ you can períodícally examine them to fix cmy workset assígnment mistakes. For exc

someone might have placed plumbing fixtures on the SÍte workset.

As you continue to assígn model elements to worksets/ you should be aware of some si

conditíons thaf might exist in your project. Some elements that can be selected and/or filtÉ

actuaüy subcomponerrts of other systems/ and as such/ their Workset property cannot be d

independentiy of the parenf system. For example/ you can select and fíÍter curtain wall pane

and mullions/ but you can change only the Workset property of the curtaín wall object, wtót

simply categorized as a wall.

Another special condition to look for is the presence of groups. Grouped objects will sho\

in the filter líst as Groups and not in their respective categories. As an example/ in Figure 5.1Í

the filter Ust shows Model Groups. Select only Model Groups m the Filt-er dialog box and u;
Isolate Elements command in the view control bar/ and you wíll see that the groups contam

eÏements in the Casework and Furrúture categories.

MOVINfi EVERY INSTANCE O» AN ELEMENT

A quíck way to move every instance of an element type to a new workâet is to use the Seleç^

Instances option from the context menu. For examplfi, selecí a chair in the modeï and ríglií--cÜ<

From the contexí menu, choose Select AU Instances >• In Entire Project. This selects ali the faijj

demente in the entire model, allowing /ou to quicldy move them au to the same workset ii^

Propertíes palette. Please note that in certaín situations where some of the eÏemÊnts selecteâ|

also hosted in groups, the Workset property will not be editable.

Another way to seíect ali instances of an eÏement is to right-click the family name in the Pro|

Browser under the Famiíies node. Simpïy navigate to your family in íts proper category.

B̂>et

^^^.^y-^^^^^:^^^^VisÍbmtyJ/Gmphic Overrides dialog box and settmg E

tomspect the contents of each ^orkset^^^ ^^ ^ ^cessary only ií you have developed^^
' Tteworkflow described »teP^ed;n^^CT^^^:y;^ project enabled

:S=ÏÍrïê£Ï5ÏS^=:=
^^s^^^s^^^^-^^^

MM^W0^^^^^^?^^^55^^^^=^^=:::toply
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start adding or editing conteni- in your project because permissions are being

managed as you work. Just remember that you cannot edit any elements (2D or 3ri\u^
one else is already editing.

You do not have to make any worksets editable unless you want to preveni oth(

members from editing certain paris of your project until you have• completed soïnp^!!?!
Making the entire workset editable allows you to freely manipulate any of the'geompÏ
workset but precludes anyone else from making changes. By edítmg at the element ^ ï ^
only taking permission ofelements you are going to change/ leaving the other elen-ienÏ

for other team members. Which option you choose to employ wÍIl be dependent on f-hL a^
you are looking to establish. 'tl^Wc

DO NOT WORK IN THE CENTRAL FILE

Once you create a cenÈral file, make sure that you never work directly within that central ftiJ
work directíyin local fíles. Working in the central file wiU change the file atíributes on the.w3

prohibit anyone with a local file from being able to synchroníze with the central fíle andlikpâ

to a loss of work. The possibility of losing a IOÈ of work and effort from team members e^sÍ

is safer to err on the side of caution by simply never opening the file.

The most important tiung to remember when you use worksharing is that every elemenl

the file and added to the file belongs to a workset. To make sure you are placing eÍementsï
proper workset while working, know there are a few tools to ensure that you select the
right workset.

One such locatíon is on the Collaborate tab/ where you initiated worksharmg. As shownl

Figure 5.19, the active workset is Exterior And Structure. This also tells you thatthe Exteriol

Structure workset is not editable. What this means is that as a user, youhave not taken omil

ship of Üús workset. However/ as we mentioned previously/ you do not need to own a wod
add elements to it. It just needs to be active in this window.

FIGURE 5.19

Setting the active

workset in the ribbon

The second location is in the status bar at the bottom of the application (Figure 5.20). The]
drop-down menu on the left serves the same function as the Active Workset drop-down m t|

Collaborate fab/ but it allows you to verify that the proper workset is active without the neec

bounce between tabs Ín the ribbon and intermpt your workflow. From this location you can

change the active workset and even open the Worksets dialog box using the small button to l
left of the drop-down menu.

FIGURE 5.20

Setting the active

workset in the status bar
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. tool located on the Collaborate tab is the Gray Inactive Worksets button. This

Afío"r/pÏpments that are not on the active workset, helping you identify what elements are

l à^s au^,7rpnt. active workset This is a temporary view state and will not affect any printmg or
E'inyour .^

• other °^on, you can always view an objecfs workset assignment by hovermg your mouse

?J^vLer'the object and viewing its workset shown in the tooltip and in the statusbar
l Poillter ^.BothÍocatíons will aiso display an objecfs family and category. In the example ^

'U.W J-^s~ l' ""— " ^ ^ ^ ^ • ^ ^ ^ ^ . . ..._..i.../.j. ;

La^vLer"the object and viewing its workset shown in the tooltip and in the i
Poillter ^.BothÍocatÍons wiU also display an objecfs family and category. In the example
(Figu?h^e/thewallïsm the Exterior And Structures workset/ in the Walls category/ and its type
showu1'^ "^^_,_ urec or. A/í+1 Qf-nrl Thprparpl-hreelocations in Figure 5.21 whereyoucansh^l/^n;Exterior - EIFS on Mti. Stud. There are three locations in Figure 5.21 whereyou can

is BÏlcJ^rlkiset:mÏe status bar, in the Properties palette/ and m the tooltip. As a useful tip/ note
see m^vartTvÏworkset listed, in the case ofthis example, Workset l (not editable)/ is not the

^rksetofthese^

ÍïS-21
Êetassignment
(,edinstatusbar'

rtíes palette'

^oltip
ition

l

b'

Saving Work
It will eventually become necessary to save your work and share your progress wiA others in the

model. You have three ways to both save your work and view the work of others: Save/

Synchronize And Modify Settings/ and Synchronize Now.

Save The Save button saves the work you have done to your Ïocal file onl^the work is not

shared orpublishedto the central füe. This can be a useful step if you are m themidd^'

aprocess and wantto make sure your work is saved but are not ready toshareAe ch^es

wïhtherest'of theteam. You canfínd the Save tool either by choosmg File > Save orby

clicking the Save icon on the Quick Access toolbar (QAT).

Synchronize WÍth Centtal > Synchmnize And Modify Settings When you are ready to

publish your work for the rest of your team to see/ you have two command choices to

synchronize with the central file. The first of two synchronizing commands is known w

Synchmnize And Modify Settings. You can access this command in a couple of ways, The first
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í^.Ï Ïe couabomte tab in fhe Syrchronize panei, as shown in Figure 5.22.
With Central flyout button is located on the Íeft of this panei. 0~' ^ ^' lne s^chj

FIGURE 5.22

Synchronize With

Central command on

the ribbon

As an alternative, you can use the Synchronize With Central button located i

Ï^OI^th^s^action and wm °pen the Syi-tchronize With CentraTdiaÍol
(Figure 5.23). This dialog box gives you some addítional tooïs to assist your workfÍow.'

FIGURE 5.23

Synchronize With

Central dialog box
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l Save i&rai Pile tefore and after synchronlang 'Ajth central

Can

• The Compact Central Model check box allows you to compact the model to save on dl

space;Itwm take someadditional saw time/ but it can temporarily decreaseyourfilj

!]8mficantly"This shouldnot be seenas a Perm^ent solution to managinga Íargeme|
r. Compactionwill decrcase the file size/ but use of the file wiUexpand the

compactedelements. Típs and techniques for reducing file size are discussed in
Appendix B.

^ Rveadditional check boxes win be available (depending on what work you have don^
!Ïme) to allow you to relincluish or keeP permission over the elements you have |
previously edited. Unchecking these boxes~means that you wjll retain ownership over|

! elements you currently own with the mode1. This can be usefu! ïf you are plamung|
continue working on the same elements and want to publish or
the model.

You can add comments to the synchronization that can be useful for tracing potential

ffi.odel conflicts later in the production process.

A final check box/ Save Local File Before And After Synchronizing WÍth Central/ allows

vnuto.save your changes locally/ get any new changes from the central file/ and then save

Íocally again/ ensuring that your local copy is up to date. This is the save option that takes

thelongest, and you might choose to uncheck this periodically if you are pressed for time

or have a large file that typically takes longer to save.

inize With Central > Synchronize Now The sccond command choice to publish

irchanges is called Synchronize Now. Choosing this option allows you to bypass the

ronize With Central dialog box and simply sync your file immediately. With this option/
. will be relinquishing ali your permissions over any elements you have borrowed;

however/ you wül remam the owner of any worksets you have made editable in thc Worksets

díalog box.

Saving at Intervals
You willbe prompted to save your work at regular intervals. Once workshanng is enabled, you

will receivean additional remmder to synchronize with the central file as well as to save your

work (Figure 5.24). You can dismiss these dialog boxes by clicking Cancel at the lower right/ but

remember/ it is a good idea to save regularly só you do not lose any work.

fcURE 5.24
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If the Changes Not Synchronized With Central dialog box appears, you will have three

options to choose from:

• Synchronize WÍth Central/ which will perform a save operation identical to that of

the Synchronize Now command.

• Synchronize With Central And Set Reminder Tntervals/ which will synchromze your file

and then pull up the Options dialog box/ allowing you to set the intervals in which you

receive this message.
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• Do Not Synchronize And Set Reminder Intervals. Selectmg this option will

Options dialog box where you can disable any further reminders.

You can modify the reminder time shown in the díalog box at any ume by clirL-n

tab/ selecting Options/ and then choosing íhe General tab. Note that this feature is í^,ü.l41el

a reminder only; it does not save the file for you.

Loading Work from Other Team Members

It is possíble to update your model ana load work from other team members wii

your own work back to Ü^e central file. This process/ called Reload Latest, basicaílv rln[L^U

the latest changes from the central file to your local file. Because you are only downlna^

content from the central file and not uploading/ thís process takes only a portion of thf^.

SWC does. To do this/ dick the Collaborate tab on the ribbon/ and choose Reload L;

Synchronize panei. The default keyboard shortcut for this command is RL.

Using Worksharing Visualization
Sometimes it helps to have íhe ability to graphically dísplay worksets and their status ip.
project using the Worksharing Display tool found on the view control bar (Figure
worksharing visual ization/ you can visualize four different values: ownership status, indii

ownership/ updated elements, and workset assignment.

FIGURE 5.25
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To display any of the values/ select the desired setting. When any value Ís selected, the

temporary view condition is indicated by colored ïiighligliímg around the edges of the
view window.

Select the Worksharing DÍsplay Settings menu item to customize the graphic appearance|
the visualizatíon overrides. The Checkout Staf-us tab of the Worksharing Display Settings

box shows three values: what is owned by you/ owned by others/ or not owned at ali

(Figure 5.26).
The Owners tab oí the Worksharing Display Settings dialog box illustrates which elemenf

owned by the users in your project If vou see users listed who do not have any enabled elei

or worksets, you can remove them from the list by selecting their username and clickíng thei

Remove User ícon at the lower left (Figure 5.27),

^-tab
^orksharing Dispiay Sensngi

Checkotit Stalus o^-ne-s Model f^iáaíes

;ksut Statüs

"g—-Owned8yMe(8lMCoOTdi

'ChmedByOthere ^ ^

["] 'NeíOwneá

bpt 5.27
lers tab

.harmgDÍspIaySettmCiS

kouí StahJs ^ Owners Modet t^xtetes

. -eMO^Ï-t^tí^^^^^ïï^^^e8to
tbe-central file that may not be apparent until you nave sy

(Figure 5.28).
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FIGURE 5.28

Model Updates tab WoFksharÍFtgDbpEaySetíJngs

Chedout Status Ownsrs Modd Updates

5how Cojor| UpdatesmthfrCertttai

Q 'Any Updstes"

B iDeÍetetíEtefr!entE"

Colsr

^TheWorksets fab allows you to color-code the model based on the workset ^^^ele^r^^n^^^^Z^^SS^
FIGURE 5.29
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,^I^^aYh^spIay8ettmgs update m your proiect is "p t" y°". 1° modify thesej
SÏ3hnMlFIL^OP!;o;nltoTdaLtheworks^

^ 5.30). Moving fhe slider to the far left wül set the desíipfïonb£wL'theÏ^tes sliderJ

[anual Updates Only/ and the update will occur when you use Reload Latest or Synchronize

^Vith Central, Slide just a bit to the right, and you will see that the display will update every 60
econds. Slide it ali the way to the right/ and your display will update every 5 seconds.
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Managing Workset Visibility in View Templates
As we described in the section "Moving Elements Between Worksets/" worksets can be used as a

different way to visualize your project using the Visibility/Graphic Overrides dialog box.
Workset visibility can also be managed as part of a view template. To modify these settings, go to

the View fab/ locate the Graphics panei/ and select View Templates > Manage VÍew Templates.

In the View Templates dialog box (Figure 5.31), select V/G Overrides Worksets to modify the
visibility settmgs in any view template. Refer to Chapter 4, "Configurmg Templates and

Standards/" for more information on view templates.
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FIGURE 5.31

Workset settings in

view templates

' Vleiv Ternplirte;

ïteis tereplateï

5iscjpiirs& ffiteí:

Visn? prõperbes

Closing Revit

Eventually, you will need to dose your project and leave for lunch/ attend a meeting,

for the day- Do not worry—the project will still be there tomorrow. But in the meantün.e/it ^

ímporíant to understand how to dose the project correctly só you do not accidentally retainl

permission over any elements and prohibit others from working in your absence. This situaJ

tion—where a team member hás accidentally left the office andnot closed the project file oïl
relinquished permissions—leaves the other team members without a way to edit elements

which the team member had permission or to even request permission. Só that you are notl

unfortunate victim of their wrath upon your return, make sure you dose the applica-
tion properly.

The most thorough way to dose the file is to simply quit the application completely. You<
do thisby clicking the X at the upper right or choosing Éxit Revit from the Application menu
You will be presenteei with a dialog box in which you can choose to synchronize with the CE

file/ save your changes locaÜy/ or discard the changes (Figure 5.32). óbviously, the best choic|
to use SynchronizeWith Central/ allowing your changes to be published and any objects you|
own to be rehnquíshed; however/ you might be in the middle of a design study and not read|
share your changes. In that case/ you may choose to save locally and retain ownership of certi

elements Just be aware that no one else on your team can edit elements you own until you |

relinquish them. Our recommendation is to always relinquish aU elements at the end ofyoi:
work session.

What if you were only reviewing the model and making some minor changes/ and you do|

want to save the changes? Close the file or application with any of the methods previously

mentioned and select Do Not Save The Project from the Changes Not Saved dialog box. You ^

then be presented with another dialog box with two choices concerning borrowed elements

(Figure 5 33). In the dose Project Without Savmg dialog box/ you can either relinquish any
borrowed elements and worksets or retain ownership of them. Clearly/ the best choíce is to
relinquish ali elements and worksets.
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[5.32
otioi15
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aUow7y7uto"mamtram^nyvÍsibilityconfÍgu^^^^^
ZL7tsulÏhZfíhuthÍs"fíl retïnsthewoïksharingcapability/ it can no longer be ^ron^eà
withthe"orifímal^ntral file because Ít will become a new central file as soon as yous^

^lT&his"methodcan alsocreate . file for review by a project manager or q^^ywntr01

^^^^ïheïaroíd^^ the model acddentaUy. Tf you elect to discard worksets/
reviewer
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you will lose any visibility settings established from worksets. You wiU <

new worksets fmm scratch if you decide to enable worksharing agam~mthef^0 cr^|

FIGURE 5.34

DisabUng worksharing
DEtaíh Mcidd frain Cenïraf

??.ïïíh!s mode! WIH cfeate3n "^ependení mQdel. You will be unabjf
to synchroníze your tí^nges wlíh the origmal central modei.

ijeracn ant:pjËïer'/fc ívorRíeiá

'•ÍQLI cm L-..te? swuthetíets.^eti rricit|c| 35 3 r.ew<-er.ti3Í s^e
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, "ró:thEci'lgln>il ":^'wï ^w-.^r,. ind^hs -•.•ofce:..^bil-t). Ve.j ^-s latsr ,-r,-.,,^
i'^^os,;^L,Bi^<ithei-;?;^hi;d>~wd<l^;thnoíci^iiK. '-'-"-'•""" -" •—' t-i"ï£

Carrc el

ünderstanding Element Ownership in Worksets
oneof thefundamental concepts in a model enabled with worksharing is the own^^.:;:^^^;^=^:^^^^â
fhat.dement-as Ionsas "oone else owns it- Determmmgwhethe"r7ou7w^Z'Zast
2ampl.^ecti"f you do not own it/ you wm^^°ri^™g^:Z^
selected element in Figure 5.35. " ——^ ^^,

FIGURE 5.35

The worksharing icon on

a selected element

i..B?Ibo^owÏgeLements/team members can take °^^híp of only portions of a worfc
^Ïi^.rTmder.of_theworkset to be edïted by ^^else7^ng^^pTe
^Ï llthLSÏlcreates a IT10re "take what You need" WroacïtoedÍtSgandu^aUyÏ
in less overlap between team members.

Etesld^automatically borrowing elements when they are edited, you can obtain owneii
an eiement or group of elements in a few other ways;

• In tine Worksets dialog box/ you can make any workset editable. You then become t

owner of the workset instead of borrowing elements within one.

4 ïoucanselect any element or series of elemente/ and take ownership of them bydi|
e worksharing icon.
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You can right-clíck any eJement in the Frojecf Browser under the Familíes node. Tn the

context menu that appears, you can take ownership of families/ groups, or views.

Vou can right-click any element in a view and choose Make Elements Editable from the

context menu (see Figure 5.36). You also have the ability to make editable the entire

workset to which the selected object is assigned.

i5.36
Íg^eleÏnt
£usi"gthe

:menu

Make WorksEtí EdftsblË

M a k e Eiemsnís E.ditab!e

inïwsïF;

Properíïes

any of thesc options/ if the selected element is already owned by another team

member/ Revit will alert you and you wiil not be able to modify the element or make it editable.

ACCIDENTS HAPPEN

However profident a team, acddents may occur on a project, and elements will get modifíed or

deleted unexpectedly. It is important to know how to recover your work when these accidents occur.

On one project, someone new to using Revit and new to the team was working on window details on

a three-sided building. In the detailing process, the new team member accidentally deleted one of

tlie walls in the project, Because the wall had sections and callouts associated with the geometry,

deleting the wall also deleted elevations, wall sections assodated with that wall, and the associated

details in plan and section. When the new team member deleted the element, he was not aware of

the mistake and performed a Synchronize With Central operation, publishing ali the deletions to the

central file. Fortunately, the error was caught before everyone else performed a Synchronize Wíth

Central, and the team did not have to resort to restoring the model from the previous night)s backup.

The team was able to use another members local file to creste a new central file, thereby minimizmg

theloss ofwork. Onceeveryone onthe teammadeanewlocalcopy,hewas abletogetbacktowork.

Had the deleted elements been more isolated Qike a conference room layout), recovery would have

been much less invasive. In such a case, you simply create a group from aU- the elements you would

like to save and then right-dick the group in the Project Browser. You will have the option to save

the group out of the file, which can then be Ínserted Ínto a different project file and ungrouped again.
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Ünderstanding Editing Requests
When working in a worksharing projecí, you do not always have to take ownershn

workset to begin editmg elements. As we discussed earlier in this chapter, it is postíkT
1-Ç |;Qownership of individual model elem.ents. ThÍs process is referred to as borroï

there can be only one owner oí a workset but mulüple borrowers oí elements within a ilÏ

If you need to work on elements thaí already belong to someone else/ you will rppl;^

thatyoucannoteditthe elements untílthe other person relinquishes them/ and vnnT..;n,'
the optior to place an editing request.

Understanding the edÍting request workflow is criticai for multiuser teams; il

transfer permíssion of objects without having to constantly save ali their work to thf

and relinquish ali worksets. Lefs look at thís Ínterchange of permíssions in more detai)

SIMULATING A WORKSHARING ENVIRONMENT

Practicing wíth a multiuser environment is not easy to describe in text, although it is

configure on your own computer. Ifyou would Ïike to work through the exercises in this sprtí.

can launch Revit twice. Remember to change the worksharing username in the application

in one of your Revit sessions before you create a new local file. And of course, remember tc

your original username once you have completed the trainíng exercises. This will give vou S

understanding of how workshared elements are controlled in a real-Ufe project. If you are -s

into your A360 account, you wiU have to sign out in order ÈO change your username.

Placing an Editing Request
Imagine you are happily working away on your model in a worksharíng environment anc

try to edit an element that someone else owns. What do you do? When that situation occi

wíll be presenteei with a dialog box that allows you to request permission to edit the elemí

from the other user (Figure 5.37).

FIGURE 5.37

Placing a request for

permission

Auiodesk Revit

Cari't editíhe eten^ênt mtí "BIM Osordhsíoi-"ressves the dement to centrai
: and relinquii^es it ana ycij Reload Latest.

Looking at the díalog box/ you have two options:

• You can click Cancel and not take possession of the element/ and then focus your et

on another part oí the design.
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Yoü can click Place Request to ask your team member to relinquish possession over the

element Ín question. When you click Place Request/ the dialog box shown in

Figure 5.38 opens.

RjíquestPla^d

íbox

EditÍ!igReque»tPlen:ed

•^ ^our request b^ been fÁas.eà tQ the u^r(s)
late when a

To continue wortíng insíead of wsïtíng for the re^wnse,
àase this diaiog ana emts! your láiwige in the error
d6abg. Your Edi&ig R.ettüfât rfi s^ be sctive awi you
íiii receive a nofïflcat&n sïhen ïtïs granted w denied,

The recipient of an editing request will see a pop-up notification appear at the bottomof the

tion/ as shown in Figure 5.39. The notification gives the recipient instant mformation

aboutthe element in question and who made the request and provides button@ to grant or deny

therequest. It also provides a Show button that finds the element m a view só the recipient can

determine the most appropriate response to the request.

JRB 5.39

ig request

ícation

ModelicOS-SiiiTtpte-Bii^dsng-AÏâ-i-eritraS

Elemerrt: Wo^setl: Waiiê: Baste Waii; i^tenor

4 7/S" Partstion íl-hr)

Requesteá by; -'ames

Mefsage; Another vsw ffqueás your
permssïion to edit Ihese etemeníí.

If you happen to miss or accidentally dose the request notífication/ there is also a smaU visual

indicator on the status bar at the bottom of your screen. _.... ...

Ït indicates whether there are any outstanding requests (both to and from you). Clicking this
icon opensthe Editing Requests dialog box (Figure 5.40). Any requests indicated by an asterisk
require you to Synchromze With Central before granting the editing request.

Granting an Editing Request
Lefs discuss the other sideof this scenario: you are the recipient of an editing request and you

are ready to grant it. Now, one of two things will happen. If you haye not changed the element/

you cansimply click Grant and the permission for the element will be transferred to the request-

ing team member.
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FIGURE 5.40

The Editing Requests

dialog box

Edítíng Requests

Oíhere pendlng Reouests
Ld "

EieïerieranciSnjcture

Wslis ; Sasic WaB: Bcíeriw. EIFS wi Mti. Sua •
Mypending Requesis

Ërsrrt

Ifyou have modifíed íhe element or one that is dependent on or hosted bv the e^^S
question/ you will be alerted that you will need to synchronize with the centraffÜebZ^a
rcquesLC^ be §ranted-The team m^ber who placed the editing requesïwUlsub^uZI
to use theReload Latest command or Synchronize With Central to reïive the^ent"

ana thenthat team member can edií the most recent version ofthat elemento p7rmiss^ë3
!hltJTires^^^^^^^^ wiíh central are fla^ed m the Eclitingïequestrdiab^^^^^^^
asterisk next to the request.

Aftery^ur editing request hás been granted, you will receive a notification similar to thol
Íov^mFigure5:41-If therectuest didnot req™ a SynchromzewÏhCenïaFop"^^^
ti^oth^team member (as indicated in the left image m PigureÏ^youcarTcoxSr.^l
^ting command íhat prompted the request. OtherwÍse/ you wiUneedto use ReÏoadlLateV
beforeyou can continue the editíng command. If you neecl to returntoaview o7th7elem'fflj

ts related to the editing request/ you can click the Show button^ Clickthe'Xto dose~t

FIGURE 5.41

(a) Notificationofa

granted editing request;

(b) Alternate notifica-

tion of a granted request

alerting you to

Reload Latest

Ç4?Moà€h íSS-Sample-Buáding-Aie-central

Element Worísetl: Wai;s: Bsúc Wail: íïï^dor -
4 ?/&" Perthion (1-hij
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Note: Retaad tatest fe reqtiired fa ^dK the
ístemeiiïs.

PERMISSXON FOR SOMBONB ELSE'S OBJECTS

situation may happen on one of your projects: someone leaves for a meetíng or goes home

ISÏLutrelmquishing permission ofborrowed eÍements and worksets. This scenario would prevent

members from editing any of the borrowed elements until that person returns to the

Kïró ana synchronizes the changes with the central ale. If that person cannot return to the office,

Í.q a workaround for this probleni. The workaround will result in the loss of the work by the

ÍÏmssing team member, but it will dear up ali the permissions issues.

} ç ^ immediate team needs outweigh the potential loss of the missing persons work, follow

these steps:

new session of Revit.

2. Click the AppUcation menu, select Options, ana choose the General tab in the resulting

dialog box.

3. Change the name listed in the Username field from your usemame to the person s whose per-

missions you are looking to release.

4. Create a new local file of the project and open it. Now simply perform a Synchronize With

Central operation, and ali the person's elements wfll be available to the êeam to edit. Then

dose the file.

5. Before dosing Revit, be sure to go back to the Application menu, click Options, and select the

General tab só you can change the username back to your own.

Relinquishing Permission
It is not always necessary to wait for a request from another team member to relinquish permis-

sion over your elements. Fortunately, there is a tool to do just that. On the Synchronize panei of

the Collaborate tab is a button called Relmquish Ali Mine (Figure 5.42). This feature returns the
permissions for any elements you have not edited back to the central file só they are available to

the rest of your team.

iURB 5.42
|linquÍsh Ali Mine

Eiã'4gi^âtes' Coliabomte -

Syncbronize Rdoad Relinqutíh
wïh Centrat ' Lsíest Ali Miri&

ichfsniïê »

Using the Worksharing Monitor
If you are an Autodesk® Subscription customer, you will have access to a useful extension

application called Worksharing Monitor, shown in Figure 5.43. This tool is available from

Autodesk's subscription site/ manage. autodesk. com. When you are working on a team project

that is enabled for worksharing/ this utility gives you real-time information about the users

participating in the project file. It also hás a convenient resources monitor to keep you informed
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of your computei available RAM/ virtual memory/ and disk;£^E2£^^^^^^s^
FIGURE 5.43

The Worksharins

Monitor is available for
Autodesk® Subscription
customers.
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Collaborating in tíie Cloud

EITtuauyyouwiuneed to collaborate with other designers. Maybe this partnershin-iJ
^lwtz^ïmee^M^^^^^
^S KÏ^d^tï! ï"^lmgwra*^P^^^ ^"^1
Ianr^n^RrlTyeT£htobeabIe.tones°tiateAeirw^^^
Saflavnfea,lK;Z 1OTA^ t?wwandcommmt c>nwha^"' ^"cZ^. Z^|
^eurefesaamway for you to not oriy share youl moddbuïa^'"m™to°nmTdZr^eïtB)|

Dritu^^h^a.tl:w.eb:basedresource toshare and mark "P Revit files. The sitefe|
^Zl(p36nü;a^,ote^\"lThesiterequIresan^^^^^^^
iSevi,°^a^p/^T_si? mtoough^^^
li^dayïhtms or doud rendering ^ use the s5e as~an onÍ^e7ouZrTtio^puo^ '

I^(Këwe5M) allows you to UPIOad and^aremodeirwZcoTbo^^ You canJ
make models pubtíc or you canshare them withonTy"ceVtam7ndivÏduaïruümLur"
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t?-44,
&tnot

|goDrive
delsonune

of the great benefits of the site beyond just document management and sharing is the

^tvíoï non-Revit users to be able to navigate the model in a read-only format. Usmg the

Í^nÏfi modeÍ we will work on throughout this book, a non-Revit user can navigate any of the

E Ï^within the model (plans/ elevations/ 3D views/ and só forth) as well as spm the model
in an interactive 3D formal Figure 5.45 shows the interactive 3D view.

|B5.45_ ^
|theA360online

^gengíne

This is an easy way to share models and allow nonusers to make comments on presetjjiews.

The site works best with Google/s Chrome web browser and works on either a Mãe or a PC.

BIM 360 Design
Although the A360 Drive website allows you to upload and download ffies as well as view Revit
models/Ít does not provide an alternative to true collaboration with Revit worksharing A service

called Autodesk® BLM 360 Design® allows teams to synchronize changes using Autodesk/s doud

services instead of an Autodesk®Revit® Server Accelerator on your WAN.
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Cloud collaboration for Revit is a paid service that can be purchased per re&i;

can learn more about the service atwww.autodesk.com/products/coT.laborat-i/,.. ..usil

BIM 360 Design is an "entitlement/" which means it Ís an additional service tha*. J

of Revit. This servíce allows you to collaborate within the same Revit model wifhn,^urls'

on the same network. As an example/ if you are working on the arcïiitectural desiern ^

project with another design firm and both of you are in different cities, BDVt 360 Dpü^
you to both work withm the same model environment without the hassle of settiní

Revit Server/ or any sort of network sharing.

BIM 360 Design can be initiated in the same way that worksharing can be: simnlv ^i:

Collaborate button on the Manage Collaboration panei of the Collaboraíe tab. Bvrli^L;.

you/ll get the Collaborate dialog box (Figure 5.46). However/ instead of selectine thpr^.

Within Your Network option, choose In BIM 360 Document Management

Ku^BM

FIGURE 5.46

Collaborating using BIM
360 Design

Coliaborate \

Vou are enafcihng coi labora ti on. This wi!E aliow multíple people to
work on the same Revií modei simultaneously.

How would you Ifke to coilaborate?

; Withmyournetwork

Coilaborate on a local or wide área networfe (LAN or WANj. The

modei wifl be converted to a workshared centrai mode).

® In BIM 360 Documerrt Managcment

Coilaborate with controiled permissfons among project members.
The model wil! be ciaud workshared In the prqject you select.

H2siLeail£oJNiâiateiisirsg_te.£hi;rf2

Selecting this option will bring up an additional dialog box called Collaborate Using The|
Cloud (Figure 5.47). Here you can give the model a name/ and you will need to choose a IOCE

to publish the model. Since you can be collaborating with dífferent teams on different projí

it's important io assign your new model to the right project location.

Note that with any BIM 360 Design® project/ it is recommended that you first set up a site|
host the model. Thmk of the site like a folder. This will keep you from having multiple modej
for múltiplo projects stored m the same location.

Once the BIM 360 Design® model is established/ additional users can be invited using íhe|
360 web portal. The límits you have to working in a 'BïM. 360 Design environment are the SE

working wíthin any other shared Revit project. You can still use worksharmg and Synchroi

With Central, check out elements or worksets/ and só on. The primary difference will be op(

your project. In Revit/ there is an icon in the Open dialog box (Figure 5.48). Your central fíles'

reside on the cloud in a location called BIIV[ 360.

Project 1

Proiect 2

Projsct 3

[5.48

ting a model using

Í60 Design

For those who have used the previous iteration of BIM 360 D"i?F"v;ously,known as C4R-^SSS^i^^^^^SSSS:ESs£S:ï^^
The Bottom Une

UnderstandkeywoAsh,ringconcepts.^Oncete^^^^^^^^^
t^Z^rh^oTaeT^thïeTocaime^ndte^^^^^^^
otnZcplr&ofecï lDcnng/s7eísures thaVeveryone is working from an updated and i

the model at ali times.
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Master It Once you have begun working in your local file/ how do you pub1n

changes to the central file? How do you download changes from the central fílo^ 1
local file?

eïii

Enable worksharing on your project. Knowmg how to activate and use worksharin- ,1
Índispensable to working in a team environment using Revit. *'4-^ig :

Master It How do you transition a single-user Revit file to a multiuser envii
using worksharing? Lll'enj

Organize worksets in your model. There is no single rule for organizing workseta n

project models; however/ they can be used to your team's advantage. You

better organize larger projects and for additional visibility control.

Master It How do you assign objects to worksets? How do you change an obierfc

workset assignment?

Manage workflow with worksharing. Once the central file hás been created/ vou uni

to organize and structure the model into logical worksets to maintam workflow wil

Master It How do worksets differ from layers in 2D CAD? What are some logii

to create worksets within a model?

Understand element ownership in worksets. EdÍtmg elements in a central file meanf.

have sole ownership over further changes to those elements. Understanding the permissil
is criticai to working in a team.

Master It How do you edit an element in the model if someone hás already taken

ownership of it in a worksharing environment?

Collaborate in the cloud. Not ali of your team members will be Revit-savvy and know:

to use the tools. In addition/ not everyone on the íeam will have a copy of Revit/ but you

might stíll need their input and comments on the design. Leaming to leverage compleme

tools to Revit is criticai to keeping a project movmg smoothly.

Master It How do you use the cloud to get feedback írom non-Revit users on

a project team?

rofkin§ with Consultants

work on large or small projects—residential/ commercial/ or industrial building

<ollaboration is an almost certain aspect of the workflow you will encounter when

lementing BIM. This chapter discusses important considerations for interdisciplinary

irdinatíon as well as the tools within Autodesk® Revit® soffrware to help you manage the

This chapter covers aspects of collaboration solely utilizing the Revit platform/ and

;r 7/ "Interoperability: Working Multiplatform/7 focuses on collaborating with other

software programs.

IN THIS CHAPTER, YOUTL LEARN TO

• Prepare for mterdisciplmary collaboration

• Coiïaborate usmg Ïinked Revit models

• Use Copy/Monitor between linked models

• Run interference checks

Preparing for Collaboration
WorkÍng alone in the Revit environment will deliver measurable increases in productiviíy/

quality, and consistency; however/ the true benefit of building information modeÏing (BIM) is the

ability to effectively collaborate between design disciplines, share model data with contractors/

and deliver useful information to fadlity operators.

The difference between these working paradigms hás been described as lonely BIM versus

social BIM. Lonely BIM can be thought of as the use of isolated BIM techmques for targeted tasks

such as architectural design or structural analysis. Social BIM is the act of sharing model data

between project stakeholders in order to enhance collaboration while developmg a building

design. The importance of increased efficiency in collaboration is the underpinning for the goals

set forth by organizations such as buildingSMART üiternational (www. bu-i Id-i ngsmart. org) or

theUK's Centre for Digital Built Britam (www.cdbb.cam. ac. u k).

The abilíty to support high-quality information exchanges necessitates the proper use of 3D

models and nongraphic data in a highly collaborative environment Although we will be

áiscussing collaboration solely within the Revit platform in this chapter/ the buildingSMART
AlUance, part of the National Institute of Building Sciences (NÏBS)/ and the National BIM
Standard (NBIMS-US) stress the need for open interoperabitíty between BIM applications.
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Once a project team decides to partidpate m social BIM—either through a team'
desi

requirements of a client—they must decide how to collaborate with BIM in a mannei.^^6i
íïhout frhenroiect lil-ecvclp. Whethpr nr nofvnnrr1i,useful to ali constituents throughout the project lifecycle. Whether or not your client

reqi
you should develop a BÏM execution plan in arder to set clear expectations relaíed tf

use of BIM.

The buildmgSMART Allíance (www.mbs.org/page/bsa)/ m an effort spoi
Charles Pankow Foundation/ the Construction Industry Institute/ the Penn State Offirp^

Physical Plant, and the Partnership for Achieving Construction Excellence (FACE),

a BIM Project Execution Planning Cuide" and template for a BIM execution plan. Yoi

fínd this information at the Penn State Computer Integrated Construction (CIC) Websii

(www.bim.psu.edu).

One of the most criticai parts of a ~BÏM execution plan Ís the definition of the proif

uses of BIM to achieve the stated goals. If you are just beginning your implementation

software, you may be using it to create 3D visualizations, or perhaps you are attemptu

increase your drafting productivity. Defining clear and concise reasons for implementü

each project will help you define where to concentrate your modeling efforts. Acccrdü

buildingSMART Alliance/ "[A] current challenge and opportunity faced by the early pmif
planning team is to identify íhe most appropriate uses for BuildÍng Information Modelii
project given the project characteristics/ partícipants' goals and capabilities, and the desii

allocations/' A listing of the common uses oí BIM along with potential value opporhmities,

rcquired resources Ís also available on the Fenn State CIC website.

According to the American Institute of Architects' "Integrated Project Delivery; A Cuide,

BIM execution plan "should define the scope of BIM implementation on the project, identíf

process flow for BIM tasks, define the information exchanges between parties/ and descríbel

required project and company infrastructure needed to support the implementation." To be!

the development of such a plan does not imply the application of integrated project deliven
(1FD). TPD is a projecí delivery approach that integrates people, systems/ business structi

and practices into a process that collaboratively hamesses the talents and insights of ali par|

pants to optLmize project results/ increase value to the owner, reduce waste/ and maximize

effíciency through ali phases of design/ fabrication/ and construction." For the purposes of-

chapter/ we wiíl consider only the collaboration and coordination befrween members of a pi

design team/ not the interactions with a client or contractor.

For addítional reading on IPD/ refer to these sources:

• Integrated PractÍce/lntegrated Project Delivery:

www.aiacc.org/~integrated-project-delivery/

• Whole Building DesÍgn Guide: www.wbdg.org

Managing the Coordination Process
The coordination process in a Revit environment begins with linking multiple files to form.

composite view of your building project Even though smaller projects might be coordinate^
withm a single Revit project file/ most moderate to large projects will be designed by multi.{
disciplines or trades working ir different offices. A project can be divided m many differentj
to meet a variety of workflow requirements. Most often/ each discipline will develop at lec

separate RevÍt projcct file, and many of these project files will be linked into each other for

MANAGING THE COORDINATION PROCESS 1 219

Because there are several workflow possibilities/ this chapter will focus on the coordi-

referenc^nnff a traditional desifín team consisting of the following:
lationÏV:

^ Architect

gtï-ucturaï engmeer

Mechanical/ eléctrica!/ and plumbing (MEP) engineers

^vorkflow within a traditional design team is more complex than vou might assume. Tf

lwleretó graph the dependencies and coordination between these parües (Figure 6-l)^you

ï,lTfiee a web of primary relationships (architect to/from structure/ and architect to MEP) and
^condary relationsíúps (structure to/from mechanica] and pipmg).

S 6.1^

atíonships •

^gdpUnary
lation

These relationships can be further parsed into physical and logical relationships. If- we use

mechanical and electrical as an example/ you can see íhat a physical relationship means making

sure a light fixture is not interfering with the bottom of a mechanical duct whereas 9 logical

relationship means making sure the electrical design (created by the electrical engmeer) properly

accounts for the load of the heating coil in a varíable air volume (VAV) box (created by the

mechanical engineer).
It is the complexity of these possible workflow scenarios that makes this process prone to

errors and illustrates the importance of proper coordination between the different disciplines of a

design team. Só/ what are the tools that can be used for collaboraüon between Revit products?

Three distinct tools are typically used in a collaboration scenario.
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CERT
OBJECTIVE

ryou|
.en

Linked Models Linking models íogether using the Link Revit tool provides full vr
fidelity of the referenced content/ showing the complete coníext of the other disdüHnn,,'

and fostering a complete understanding of their geometry. The data can also be

shown in any manner appropriate to the use. Vou can turn it on or off/ half-tone

enhance it with color or line pattern overrides. Lmking also provides support for the

Interference Check/ Copy/Monitor/ and Coordination Review tools.

Copy/Monitor Copy/Momtor is a powerful tool available in ali pmducts built 01
platform and is considered the most intelligent of the coordination tools. It offers sev^r-.i l

benefits. It lets you íink Revit files from other team members (structural engineers or

engineers) and copy key elements from their model mto yours. Once that link is

can monitor that relationship and know whether the element hás moved 01

you receive updated models from your team members. A basic example of using this

would be copyíng the structural grid into your architectural file. If the grid

with subsequent updated models/ you will be instantly alerted to the change. Note thaf- \^,

not recommended to copy/momtor ali the elements from a Imked file. The suggested wnrl^.l

flow is to only copy/monitor the key elements you need to track.

Interference Check In many cases, the only workflow requirement is to verify that itemg

from another discipline are not interfering with your items. The Interference Check tool

used to check between categories wíthin a single model or between linked models.

INDIANA UNIVERSITY BIM REQUIREMENTS

In 2009, the University Architect's Office at Indiana University (www . i u. edu) announced that iÍ

would requíre the use of BIM on ali projects with a capita! value of over $5 million. Accompanyin|

the announcement was the release of the IU BIM Standards and Project Delivery Requirement

which induded a BIM execution plan template and IPD template—developed under the guidance ol

Autodesk and SHP Leading Design (www.shp.com). Although the uníversitys BIM requirementsl

seemed new at the time, the desire to ensure the maximum reuse of information had been evolvint

at IU for several years, beginning with its implementatíon of integrated GIS (Geographíc Informatiói

Sysíem) tools for campas and fadlity management in 1996.

One important excerpt from these requirements focuses on the organization of the interferenc

checking (aka clash detection) pí-ocess. Within the IU BIM Standards & Guidelines for Architects|

Engineers, & Contractors, rules have been established for classifying clashes between modeled elè|

ments. Levei One clashes are considered criticai and include ductwork and piping clashing wit

ceilings, rated walls, or structure; equipment clearances interfering with structure are included

Levei One as well. Levei Two dashes are less criticai but include casework clashing with electncsi

fixtures and structure versas specialty equipment. Finaiïy, Levei Three clashes are still importanj

but are a lower priority, These include casework dashing with walls and plumbing interfering witt

mechanical equipment.

These requirements may be defíned differently by other dients, but Ít is criticai to understand

importance of using interference-checking tools for logical groups of model elements. Checlíing féj

clashes throughout an entire model will yield a plethora of unusable data and will ïimit the effectiví

ness of model-based coordination.

For more infonnation, visit the IU BIM site at:

http£://cpf.^u.edu/cap-itaT.-projects/consu'Ltants-contractors/-;ndex.htmT-

Given the range of available tools for collaboration/ they are not necessarily applicable to ali

Ínterdisciplirary relationships. As shown in Figure 6.2, only the most appropriate tools should be

applied to each collaborative situation. These situations are merely suggestlons based on our

experience. The needs for your collaborative workflows may vary.

plfiüRfi6.2
;ug^tions,foL
^llaboratlon

^usedbetween

disdpUnes

Linked ModeÍs

Ïnterference Checking

Copy/ Monitõrini

Architect to Stmctural Engineer The relationship between the architect and the structural

engineer is becoming closer as we strive for lighter structures and more innovative design. In

many respects/ structural engineers may be affectmg the building aesthetic as much as the

archítects. Thus/ this workflow may be considered the most crucial and should be

bidirectional.

Architect to Structural Engineer: Copy/Monitor and Coordination Review By using

Copy/Monitor/ structural engmeers can create a strong/ intelligent link between the

structural and architectural models. In doing só/ they can easily track the changes in the

architecfs model that will affect the structural design. Structural designers are also able to

create geometry m their model using these toais/ which can be directly or Índirectly

related to architectural elements such as walls and floors.

Remember that coordinatíon of relationships for datmn (grids and/or leveis) should be
established at the begínnmg of a project. For example/ does the architect "own// the leveis

and the grids—or will the structural engineer? Conflicts due to a lack of proper plarming

will negatively impact the effective use of the Copy/Monitor tools on your projects.

Structural Engineer to Architect: Interference Check The architecfs primary

requirement for the structural model is to include the structure in context and to know Íf

the structure is interferirg with any architectural elements. For this workflow/ it is
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Using Linked Models in Revit
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FIGURE 6.3

Linked files must use the
sanie platform

versíon, and ali

worlísharing team

members should use

the same build, The

build number can be

found in About
Autodesk Revit.
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Shared Positioning
In the collaborative process of sharing ínformation via linked models/ the coordinafed positíon-

ing of each model is of paramount importance. To ensure accuracy/ every projecta BIM execution

m must include agreement on a common coordmate system and origin. rfhis section will help

develop a fundamental understanding of the coordinate systems within Revit só you can

configure and manage them in your projects.

We will begm our descripüon with a símple statement: there are hvo coordinate systems in

every Revit project, project internai and shared. Each system. hás essential features and limita tions.

Froject Internai Every Revit project hás an internai coordinate system referred to in several

places as project internai. The origin of this coordmate system is at first marked by a ProJect

Base Pomt; however/ this reference point can be moved away from the internai origin. We

discuss the Project Base Point m greater detail later in this chapter.

The project internai coordinate system cannot be changed/ and your model should be con-

structed withm a one-mile radius oí the mternal origin. The true origín in Revit is referred to as

the Project Start Up Point, and the Project Base Pomt can be reset to this point by setting it to
Unclipped, right-clicking tine icon/ and selectmg Move To Startup Location.

A complementary component of the project internai coordinate system is the view orientation

of ProJect North. This settíng is the default and can be found in the View Properties of any
plan. We strongly recommend that your model be created in an orthogonal relationship to the

project víew or as you expect the plans to be oriented on a typical sheet. Your project s actual

relatíon to true north will be establíshed via shared coordinates.

Shared Coordinates In simple terms, shared coordmates are just a way for the project team

to use the same work point. In other words/ the shared coordinate system consists of a single

orígin and true north orientation that can be synchronized between models and even

Autodesk® AutoCAD® and Autodesk™ Civil 3D® drawings. In the diagram shown in

Figure 6.4, you can see an architectural model and structural model linked together. Each

model was created using a different project internai origm (not the recommended method)/

but their shared coordinates were synchronized.

It is criticai to establish the location of the Project Base Point and Survey Point as early as
possible in a project. Qnce the project is underway, moving these elements without disrupting

the project schedule is almost impossible. Qn larger-scale projects or campuses/ many agencies

(such as urúversities or other owners who have multiple buildings) are mandating where the

Survey Point and Project Base Poínt should fali as part of their standards. It is recommended that

both the owner and project teams coordinate the location of the Survey Point and Froject Base

Point as part of tine project kick-off process.
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FIGURE 6.4

Diagram of the
relationship be twe e n

project internai origins

and shared coordinates

in linked models

Internai Origin
ofSíructural
Model

A

Shared Origin

Internai Origin
ofArchitectural
Model

LlMITATIONS ON USING SHARED COORDINATES FOR EXPORTING

A^though you can useeiúíeï Project Internai or Shaï-ed as the settíng for Coordinate System Basis

ï e^rting CADformats'there are some limitations. Ifyou are exporting sheet views, thepïan

data wiU aiways use the project internai coordinate system. Using the ExportViews On SheeÈsAnd

Liaks As Externai References option during export does no£ change this fimitation. We recommend

usíng pkn views—not sheets—for issuing 2D CAD backgrounds to project psrticipants who arenot

using Revit. Refer to Chapter 7 for more detaiïed mformatíon on exporüng to other file types.

Acquiring or PublÍshing Coordinates
There are two ways to synchrorúze shared coordinates between Imked projects: Acquire

Coordinates and PubUsh Coordinates, A simple way to understand the difference between these
tools is to think of them in terms of pulling versus pushing:

• Acquire = pull

• Fublísh = push

It is important to understand the situations m which you would pull or push coordmates

between linked files. A typical workflow for estabUshing a synchromzed/ shared coordmate
system on a single building project is as follows:

l. A separate site model is generated m which the Survey Point (SP) in the Revit project is
coordinated with geodetic survey markers or station Unes. The site model is linked into

the architectural model. This file is located manually m a position relative to the building.

Do not move or rotate your buüding to the Unked sue model!

2. From the Manage tab/ select Coordinates > Acquire Coordinates. Fick the Imked file/ and

the origin of the shared coordinate system and the angle of true north m your model will

be synchronized with those in the linked file.

3. Ali engmeers or consultants using Revit should obtain a copy of Üie site model and repeat

steps l and 2. When linking other project models that have already been synchronized

with the site model, they can be placed using the Auto-By Shared Coordmates option m

the Insert Link dialog box.

ACQUIRING COORDINATES FROM A CAD FILE

A common scenario in a project workflow begins with the architect beginning a design model and

receiving a 2D survey file in DWG format from a civil engineer. The survey is drawn in coordinates

that are geospatially correct but may not be orthogonal to true north. The architect should crea£e

the model dose to the internai project origin; however, the ajchítect will need to ensure that the

building and survey coordinates are synchronized for properly oriented CAD exports and for coor-

dination with additional ünked Revit models from engineers in later phases of the project.

The architect wiU link the 2D CAD file into the Revít model but wiÏl first manually place it-

moving and rotating the CAD file to be in proper alignment with the building model. Once the

link is in place and constrained (or locked), the architect will acquire the coordinates from the

DWG survey by switching to the Manage tab, selecting Coordinates > Acquire Coordmates from

the Project Location panei, and then dicking the DWG link. This will not affect any views that are

oriented to project north—onïy those set to true north will âisplay the orientation established by

the coordinates acquired from the survey file.

For a campus-style project in which you might be creating multiple instances of a linked

building model/ you would most Ïikely use Publish Coordinates to push mformation from a site

model mto the linked building model. Here is how that would work in a hypothetical scenario:

l. Assuming a site model and building model were created in Revit, you would begin by

opening the site model and linking the building model into the site.

2. Adjust the position of the first instance of the linked buildmg model to location A.

3. From the Manage fab/ select Coordmates from the Froject Location panei and then clÍck

Fublish Coordmates. Pick the linked building model.

4. The Location Weather and Site dialog box will open, and you will creste a duplicate

location named Location A.

5. Copy the linked building model as required for each subsequent location. Repeat steps 2

through 4 for each copy. As shown in Figure 6.5, there are three locations (Location A/

Location B, and Location C) that represent each instance of the linked project model.

6. When you dose the site model and open the building model/ you catí link the site model

to the building using any of the named location references you pushed into the

buüding model.
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FIGURE 6.5

Creating multiple
locations for a single

linked model

Locatii

Ussd faf or

other buildings,
irojecí osi the site and in reiaüon to

one projecí,

The unclipped PBP can be moved in relation to the internai origin/ tl-ius creating a secondary

reference point for spot coordinates, spot elevations/ and leveis—as long as the measurmg

parameter (either Coordinate Origin or Elevation Base) is set to Project Base Point in the

respectivo type properties of such annotation elements. Moving the clipped PBP Ícon is the

equivalent of using the Relocate ProJect tool/ whlch moves the project relative to the shared

coordinates system.

Unless your project requires the use of a secondary point of reference other than the Survey

Point/ we recommend you do not adjust the PBP and that you make sure your building model

lies within a dose reference of this point, such as the comer of a property Une or Íntersection

of column grids A and l.

Survey Point The Survey Foint (SP) is the equivalent of a station pin or geodetic survey

marker in a civil engineering drawmg (Figure 6.7). This is the point that will be coordmated to

real geospatial coordinates. For coordination with Autodesk® Civil 3D® software/ the SP is

used when a Revit project is exported to the ADSK file format.

Using Project Base Point and Survey Point

^ipr^deltwo.graphic ob)ects to identify.the pr^ct B^ Po^t and fhe Survev Poínt.
tfauu^mpIate8'theserintsarevisiMem
Ísphyedm anyother plan viewby openm§ theVrsÍHlTty/LGrTpuhKlLOv^rTdTd^ channalso be

FlfiURE 6.7
lhe Survey Point can be

considered similar to

a real-worïd geodetic

gurvey marker.

ïlir.'^

Sn^d Siïe-

:A1i' ff Q'
Elsv 5' O"

FIGURE 6.6
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settings are found under

Site in Visibility/Graphic
Overrides.
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Spedfying a particular location for the SP based on civil engineering data is not a requíre-

ment. For smaller projects/ the SP and shared coordinates may never be used at ali; however,

they are criticai in the use of analytical tools for daylighting and solar analysis.

To further expand your understandmg of these points and what happens when they are modi-

fied/ we created a sample file for your reference. Open the file c@6-Sha red-Points . rvt, whtch you

cari download from this book/s web page at www.wl ley. com/go/masteri ngrev-i t2020. In this file,

you will find three copies of the Levei l floor plan. Qne view is configured to display the project
coordmates/ another view displays the shared coordmates/ and the third view displays a combtna-

tion of the two. There are also two types of spot coordmates: one mdicating project coordinates m

which the values are prefixed with the letter p, and the other indicatmg shared coordmates with the

prefix of s. You can open these three floor plans and tile the windows (click the View fab/ select the

Window panei, and choose Tile/ or type the keyboard shortcut WT) to get a better sense ofhow

these pomts affect one another (Figure 6.8).

In this sample file/ you can explore the effects on your model's coordmates of movmg the

Project Base FoÍrt and Survey Point, When selected, the Project Base Point and Survey Pomt

have paperclip icons that determine the behavior of the points when you move them. Qicking

the paperclip icon changes the state from clipped to unclipped and back to clipped.
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FIGURE 6.8

Using tiled windows

helps you examine the

effectofprojectand

shared coordinates.
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• Survey Pomt Clipped

• Move the SP (Survey Point).

• SP coordinates do not change.

• Shared spot coordinates change.

• Model elements do not move.

The clipped SP represents the origin of the shared coordinate system. Moving it is the

equivalent of setting a new origin point. Use caution Íf you must move the shared

coordinates origin if linked models already exist in which the shared coordmates have

already been synchronized. In such a case/ each Unked model must be opened and

manually reconciled with the model m which the origin hás changed.

• Survey Point: Unclipped

• Move the SP.

• SP coordinates change.

• Shared spot coordinates do not change.

• Model elements do not move.

Movmg an unclipped SP essentially does not do anything. It does noí affect spot coordi-

nates, and it does not affect the origin of exported files.

USE PlNNING TO PROTECT COORDINATE OMGINS

An excellent way to preveni acddental modification of your projects coordinate systems is to pin

them. To do só, you must fírst make sure the Survey Point ana Project Base Point are visible in a view

(às we discussed previously in this section). Next, select each point and click the Pin button on the

Modify panei when the Modify | Project Base Poínt or Modify j Survey Point ribbon appears.

Attachment vs. Overlay
Lmked Revit models use what we will call a portabüity setting that is similar to the way Xrefs are
handled m AutoCAD. Although this settmg is not exposed when you initially Imk a Revit model,
you can modify the setting by switching to the Inseri tab and selecting Manage Links. Change

the settmg in the Reference Type column as desired (Figure 6.9).

Attachment The Attachment option ensures that the Imked model will be included if the

host model is subsequently linked mto other hosts. For example/ if Project A is linked into

Project B as an atiachment, when Project B is linked into Project C, Project A will automatically

be included as well.

Overlay The Overlay option prevents linked models from being included if the host model
is subsequenüy linked into other hosts. For example, if Project A is Imked into Project B as an

overlay, when Project B is linked into Project C/ Project A wül not be mduçied. When you

initially Imk a model that contains other Imked models with the Overlay option, you will be
notified that those links will be mvisible (Figure 6.10).
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FIGURE 6.9
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When you are linking worksharing-enabled files from consultants/ you will first need to

decide whether you need to mamtain the worksets in the linked files. Even though you may not

have direct access to your consultants' servers, the softv^are will atternpt to reconcile the location

of each project modeFs central file location. We recommend handling each received project file

using one of the following options:

• Open the project using the Detach From Central option/ choose Preserve Worksets/ and

then save the project as a new central fíle on your server. Reter to Chapter 5 for specífic

mstructions on this process.

• Open the project using the Detach From Central option/ choose Discará Worksets/ and

then save the file.

If your team decides to disable worksets in Imked fües received from consultants/ you will

avoid any problems related to the central file not being found; however/ you will not be able to

extend workset vísibility settmgs tnto the ünked files or use worksets to selectively load content

from the Imked model into your host project. If you preserve worksets/ you can continue to use

worksets in the Imked model to your advantage. For exarnple, when you first link a

worksharing-enabled model mto your project, you can use the Specify option associated with the

Open butíon in the Import/Lmk RVT dialog box, as shown in Figure 6.11.

FIGURE 6.10
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Linking Files with Worksharing
iï you are using linked Revit models where
enabled:toel;e\TwÏu7dZ::^lm:::,rreoÍte

imng with this section.

At any time throughout the development of the project, you can adjust the loaded worksets

from Imked fíles very easily. From the Manage tab or the Insert tab in the ribbon/ click the

Manage Links button. In the Manage Links dialog box (Figure 6.12), select one of the Imked RVT
fíles, and if it is a worksharing-enabled füe/ click the Manage Worksets button to open the

Worksets dialog box. We describe this process in greater detail in the next section of tHs chapter.
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FIGURE 6.12
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Üsing Worksets to Organize Linked Models
^g we discussed in Chapter 5, we recommend that you create and reserve a workset for each

linked RevÍt model, such as Link-RVT-Structure or Línk-RVT-HVAC. Thís simple step will allow

members to choose whether they would like any/ ali/ or nane of the linked models to

be loaded when working on a host model. To enable this functionality/ use the Specify setting m

the drop-down optíons next to the Open button.

When the Worksets dialog box appears/ select the wwksets reserved for the linked models

and set their Open/Closed status as you desire. The benefit of using worksets to manage linked

Revit models is the flexibility it offers a project team. When a team member doses a workset

containing a ünked model/ the linked model is unloaded only for that person—it does not

unload for the entire team.

Expanding Workset Properties for Linked Models
Aáditional flexibility can be leveraged with the Workset parameter m both the instance and type
properties of a linked model. In a large and complex project that consists of multiple building

elements where some of the elements are identical/ each may consist of multiple línked models:

architecture/ structure/ and M.EE Figure 6.13 shows a simplifíed represeni-ation of such a design

where the Podium hás one set of models and Tower A and Annex are identical to one another/ as

are Tower B and the Fenthouse.
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in Chapter 18, "Documenting Your DesignV
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In Figure 6.13, there are three Revit models that represent the podium and the two towers (A

and B} for each discipline (Archl, Arch2, and só on). There are multiple instances of several of the

línked models. For each instance of a linked model/ you can specify the Workset parameter só

that the workset instance property represents the building element, and the type property reflects

either the entire discipline or one of the discipline models/ as in this example:

• Instance workset: Tower A

• Type work&et: Link-Architecturel or simply Lmk-Aïchitecture

Using this example/ vou can choose to open the Tower A workset/ which would load ali the

discipline models but only for Tower A/ or you could choose to open the Lmls-Arcíiitecture

workset/ which would load only the architectural models but for ali the building elements. You
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can modify the workset-type properties ordy after placing a linked model in your proj(

this setting by selccting an instance of a linked model and opening the Properties palettç ^ ^
then dick Edit Type. Although this functionality can offer a variety ofbenefits to your 0^
team/ it should be used with care and proper planning because it can adversely affect

vjsibilíty if you are using worksets for visibility manipulation.
Worksharing-enabled linked models also afford you the flexibilíty to adjust the visibiln

project elements for the entire project/ withouí relymg on individual settings per view or

maintenance of view templates. For example/ grids and leveis are not usually displayed f^

linked models because their extents are not editable in the host model and tbe graphics

match those in the host model. Without worksets/ the owner of the host model would havo^ l

establish visibility settings for the linked model wÍthm ali vicws and hopefully manage thos
settmgs in view templates. Assuming the owner of the Unked model maintains the leveis

grids on an agreed-upon workset such as Shared Leveis And Grids, you will be able to dosp-+hJ

workset in one place/ thus affecting the entire host projcct. To modify the workset opti<

linked Revit models, follow these steps:

l. Open the Manage Línks dialog box and switch to tíie Revit tab.

2. Select one of the lirked files and click the Manage Worksets button.

3. In the Manage Worksets For Link dialog box/ select the worksets you would like to dose.,

click the Close button, ard then click Reload.

4. Click OK to dose the IVtanage Links dialog box.

RELATIVE PATHS OF LlNKED MODELS |

If your team is working in a situation where your project files are regularly transferred between |

multiple locations throughout the design process, you may find it difficuÏt to maintaín linked files |

(they are automatically unloaded when the file is exchanged), even ifyou are using relative paths. To |
alleviate this problem, try keeping the linked mode!s and CAD fües within subdirecfcoríes of the ^

central file. For example, ifyour central file is saved in W: \Ar chi tecture\BIM, trykeepinglinked \

CAD files in W: \Arch-itecture\BIM\Links-CAD and linked Revit models from consultants in

W:\Arch-itecture\BIM\L-i'nks-RVT.

SummarizÍng the Benefits and Limitations of Linked Models
Lefs review some of the benefits and límitations of usmg linked Revit models. You should

carefully consider these aspects not only when preparing for Ínterdisciplinary coordination but

also when managing large/ compiex projects with linked files.

The following list highUghts some of the benefits:

Tagging Elements in Linked Files Most model elements from a linked model can be tagged

in a host model. Lmked views can also bc used if the annotation exists in the linked model

and needs to be displayed m the host.

Scheduling Elements in Línked Files In the Fields fab of the Schedule Properties dialog
box, check the optíon Include Elements In Links.

Copying/Fasting Elements from Linked Files In a host model, use the Tab key to select any

individual element witiun a linked file, and you can use standard copy-and-paste techniques

to create a copy of the element in the host model.

Hiding Elements in Linked Files In addition to having full contrai of a linked model s
visual fidelity through object styles/ you can use the Tab key to select an individual element in

a linked file and use the Hide In View commands as you would on any element withín the

host model.

The following list highlights some of the limitations:

Joining Walls Walls cannot be joined between linked Revit models. Consider alternative

graphic techniques such as using coarse-scale black solid fill to mask unjoined walls.

Openíng Linked Models You cannot have a host model with loaded Unked models open m

the same Revit session as the línked model files. Either separate Revit sessions must be

launched or the host file must be closed before opening a linked model. If you choose not to

follow either of these options and open the link in your current session, the linked model will

be unloaded and need to be reloaded after the edits are made,

Using Linked Models—Exercises
Before you begin the exercises in this chapter/ download the related files from this book's web

page. The project files in each section's exerdse should be saved because the lessons will build on

the data. In this first exercise/ you will do the following:

• Link the architectural model to a structural project.

• Establish shared coordinates.

The structural model is essentially a blank project with a few element types specifically built
for this chapter's lessons. Lefs get started workmg with shared coordinates:

l. Openthesampleprojectfilec06-l-Structure.rvtorc06-l-Structure-Metnc.rvt

ana activate the Levei l fl-oor plan.

2. Switch to the Inseri fab and select Lmk Revit or click Manage Lmks/ go to the Revit tab

dialog/ ard click the Add button to add a new linked model. To make the steps easier to

follow/ the rest of this chapter will use the LÍnk Revit button on the Inseft fab/ but both

buttons will give you the same result.

3. Using either method from step l, navigate to the file c06-2-Arch-itecture. rvt or

c06-2-Archi'tecture-Metr-ic.rvt.

4. Set the Positioning option to Auto - Center To Center and click Open.

5. Activate the South elevation view and use the Align tool to bring the Imked model's Levei

l down to align with Levei l in the host model if necessary.
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Remember/ linked models should be aligned to the geoinetïy in the host

modeled elements in the host model ghould be as dose to the internai project n-r;^
as possible. lëui -j

6. Switch to the Manage tab/ and from the Project Location panei/ select Coordü

Acquire Coordinates. Pick the linked model.

The elevatíon value displayed in the levei within the host file hás changed to
shared elevation in the linked file. This is because the Elevation Base parameter

level/s type properties hás been set to Survey Point.

7. Save the project file for subsequent exercises in this chapter.

MODIFYING ELEMENT VlSIBILITY IN LlNKED FILES

Once you have linked one or more Revit files into your source project fíle/ you

adjust the visíbility of elements within the linked files. By de-fault/ the display settings i]
Vísibility/Graphic Overrides dialog box are set to By Host Víew for linked fíles/ which meí
model objects in the linked files will adopt the same appearance as the host file. Tn the foliou
exercise, wtí will shovv you how to customize these settings to turn the furniture off in the lii

file and then display the room tags:

l. Continue thís exercíse with the strucíural model fhat you saved wíth the linked arclüt

tural model.

2. Activate the Levei t floor plan from the Project Browser.

3. Go to the Víew fab Ín the ribbon/ locate the Graphícs panei, and

In the Visibility/Graphic Overrides dialog box, select the Revit Links tab.

You will see Üie línked archÍtectural model Íisted as an expandable tree. Click the plus

sign next to the name of the linked fíle/ and you wíll see a numbered instance of the lii

This allows you to customize the visibiUty for each instance of a linked file if you have

multiple copies of the línk in the host file.

4. In the row displayíng the name of the linked file, click the button in the Display Settirtgsj
column that is labeled By Host View.

Doing só opens the RVT Link DÍsplay Settings dia.log box.

5. To begin customizing the dísplay of elements in the linked fíle, you must fírst choose thí
Custom optíon in the Basics tab, as shown in Figure 6.14. Thís enables ali the optíons in

each tab of the RVT Unk Display Settings dialog box.

6. Select the Model Categories tab and choose <Custom> in the drop-down list at the fop oí

the dialog box/ as shown in Figure 6.15.

7. CÍear the check marks from Üie followmg categories: Casework, Furniture, and

Furniture Systems.

8. Click OK to dose ali open dialog boxes.
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^oordínatlon Review comm.and automatically monitors differences between host and linked

gleinents that were previously bound with the Copy/Monitor command.

Although these tools are mdeed powerful and have no similarities to CAD workflows of the
t ít is Ímportant to employ proper planning and coordinatíon wifh your desígn team. The

familiar adage of "quality over quantity// holds true for the implementation of coordination tools.

It ?^y not ^>e necessary to create monitored copies of ali structural elements within the architec-

tura.1 model. How would these affect project-wide quantity takeoffs for the sake of minor

Íniprovements m graphic quality?
We reiterate the necessity of developing a BIM execution plan to determine important aspects

of the collaboration process. When using specific coordination tools such as those in Revit/ teams

jnight plan on issues such as these:

•• Who is the "owner" of grids and leveis?

• Who is the "owner" of floor slabs?

• Are structural walls copied/ monitored/ or just Unked?

• How often are models exchanged?

• How are coordination conflicts resolved?

A seemingly powerful BIM tool will not replace the need for professional supervision and the

standard of care implidt to respective disciplines in the building industry. Thus/ there is no

substitution for the most important part of effective collaboration: communication. Without open

and honest communication, the coordination tools will discover conflicts/ but the results may be

Ígnored/ dismissed/ or overwritten to the detriment of the team's progress.

Using the Copy/Monitor Command
The Copy/Monitor command allows you to create copies of linked elements for better graphic

contrai of the elements while mamtairúng an intelligent bond to the linked elements. If the linked
element changes in a subsequent iterati.on of the project file/ the changes are detected in the

Coordination Review tool/ which we will discuss next.

With the structural model saved from the exercises in the "Using Lmked Models—Exercises

section/ switch to the CoIIaborate tab and select Copy/Monitor > Seíect Línk. Fíck the línked
architectural model, and the ribbon will change to Copy/Monitor mode. Click the Options icon
to open the dialog box shown in Figure 6.16.

As shown in Figure 6.16, the Copy/Monitor Options dialog box in Revit is divided Ínto five
tabs representing the elements available to be copied and/or monitored. For each element tab/

there is a list called Categories And Types To Copy. As shown in Figure 6.17, the Floors tab lists

the available floor types in the linked model in the left column and host model floor types in the
right column. Notice that any of the linked types can be specified with the option Don't Copy
This Type. This feature can be used for quality control if your projecfs BIM execution plan states

that certain elements are not to be copied. For example/ if walls are not to be copied/ switch to the

Walls tab and set ali linked wall types to Uon't Copy This Type. You can also use the option Copy
Original Type if the elemenf fype exísts in the línked file but not in the host fíle. Affer one or
more of these elements are selected using Copy/Monitor/ the type mapping will be

synchronízed.
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FIGURE 6.16
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At the bottom of the Copy/Monitor Optíons dialog box/ you will fínd a section caiïed
Additional Copy Parameters for each element tab (refer to Figures 6.16 and 6.17). The addiüon|
parameters are differentfor each element category. For example, when leveis are copied and

monitored/ an offset and naming prefix can be applied to accommodate the difference between

the fínishfloor levei in a línked architectural model and the top-of-steel levei in the host struc- i
tural model.

Let/s take a closer look at each of the element category options available
Monitor tool.

Leveis In most cases/ the difference between the location of a structural levei and an

architectural levei may lead to the presumption that you would not want to copy leveis

between files. However, maintaining an offset betvveen linked and host leveis can be quite

desirable. Keep m mind that the offset will apply to ali copy/monitor selections. Thus, if a ,

^structural levei needs to be offset by a different value/ create the levei in the host model ana'

use the Monitor command to create the intelligent bond to the linked model/s levei. The

difference will be mamtaÍned through any modifícations in the linked model.
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Grids Copying the grids is usually a strong workflow. You can use the options on these tabs

to convert the grid bubbles used by the architect mto those used by the struchiral engmeer. It

is also possible to add a prefix to the grid names. For instance/ you could add the value S- in

the prefix field/ and then grid A from the architectural model will come into the structural

model as S-A.

Columns The structural engineer can choose to replace any column—architectural or

structural—m the architectural model with an appropriate structural column; however/ this

implies that the architect will mamtain an understanding of where differentiating colunrn

types would exist. Realistically/ the stmctural elements should exist only in the structural

engineer/s model and then link into the architectural model. The architect may then choose to

either copy/monitor the Imked structural columns with architectural columrLS (which act as

finish wrappers) or place architectural columns along the monitored gríd lines. In the latter

option/ architectural colunms will move along with changes in grid Une locations but will not

update if structural columns are removed in the Imked model.
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Walls and Floors Similar to columns/ structural walls that are important to th(

process may be better managed in the structural model and linked into the archite

model. If you decide to use a copy/monitor relationship for these types of elf

to create uniquely named wall types for structural coordination. Name such waH\ ^

manner that makes them display at the top of the list in the Copy/Monitor Oütinr-o -i .^

box. Vou can do só by adding a hyphen (-) or underscore (_) at the beginning oi

type name. e Wau|

Finally, make sure you select the check box Copy Windows/Doors/Openmgs

Copy Openings/Inseris for floors só that you also get the appropriate openings forth^l
components m the morútored elements. - o- *"^ «iosej

Using the Copy/Monitor Command—Exercise

Continue with the structural model saved in the previous exercise in this chapter. In thi;;

you wül do the followmg:

• Use Copy/Monitor to establish new leveis and grids.

• Use Copy/Monitor to create floors.

• Link the new structural model back to the architectural model.

• Use the Monitor option for grids in the architectural model.

These steps will establish the intelligent bonds between elements in the host file with the
related elements in the linked model. With the structuraï model open/ activate the South ele\

tion view. Then follow these steps:

l. Switch to the Collaborate fab and select Copy/Monitor > Select Link. Choose the
Imked model.

2. On the Copy/Monitor tab/ click the Options button.

3. Select the Leveis tab/ and under Categories And Types To Copy/ make sure the rows

New Type are set to TOS Head (Survey Pt). In the Additional Copy Parameters sectioi
the bottom of the wüidow/ set the followmg options:

• Offset Levei: O' 6" (-150 mm)

• Add prefix to Levei Name: T.O.S.

4. Select the Grids fab/ and under CategorÍes And Types To Copy, make sure the rows un|

New Type are set to 1/4" Square (6.5 mm Square).

5. Select the FIoors tab and set the following options under Categories And Types To Copj

• Arch SIab 6" (150 mm): LW Concrete on Metal Deck

• Set ali other entries under Origmal Type to Don't Copy This Type.

Remember that you can select multiple rows in the Categories And Types To Copy lístl
pressíng the Shift key whüe selecting a range of rows. You may then make a selectíon

the New Type column for any row/ and ali the selected rows will be modifíed.

In the Additional Copy Parameters section, set the following option:

• Copy Openmgs/lnserts: Yes (checked)

6. Click OK to dose the Copy/Monitor Options dialog box.

7. From the Copy/Monitor tab of the ribbon/ click the Copy button.

8. Activate the South Elevation view. Select the Levei 2 and Roof leveis m the linked model.

Leveis in the host model should be created 6" (150 mm) below the linked leveis with the
prefix T.O.S. (Top Of Struchire).

There is already a Levei l in the host model. You will need to use the Monitor tool to

establish a relationship to Levei l in the linked model.

9. From the Copy/Monitor tab of the ribbon, choose the Monitor button and select Levei l in
the host model.

You can only select leveis in the host model for the first pick.

10. Select Levei l m Üie linked model to complete the monitored relationship.

You will see an icon appear near the midpoint of the levei indicatmg that it is now

monitormg the levei in the linked model.

11. Activate Section l and return to Copy mode by clicking the Copy button in the Copy/
Monitor tab of the ribbon.

12. Select the floor in the linked model at Levei 2.

13. Activate the Levei l floor plan and make sure the Copy tool is still active. Check the

Múltiplo option in the Options bar.

14. Select ali the visible grids using any selection method you prefer.

15. Click the Füúsh button in the Options bar to complete the multiple copy process for the
grids. Do not clíck the Finish icon m the Copy/Monitor tab of the ribbon without fínishmg
the Multiple selection mode first.

16. Click the Fmish icon in the Copy/Morütor tab of the ribbon to exit Copy/Monitor mode.

If you now select any of the grids or leveis in the host fÜe/ you will see a morútor Ícon near the

center of the element This icon indicates that the intelligent bond hás been created behveen the

host and the linked element and wÜl evaluate any modiíications in the linked fíle whenever the

file is reloaded.
Save and dose the structural model and then open the ardútectural model, C06-2-

Architecture.rvt or c06-2-Arch-itecture-Metnc. rvt. Using the procedures youhave

leamed in this chapter/ link the structural file mto the architectural model. Placement should be

done Ín the Levei 1. floor plan using Auto - By Shared Coordinates positioning.

Use the Copy/Momtor tools in Monitor mode to establish the relatíonships of the grids
between host and linked models. Doing só will ensure that changes to grids in either model will

be coordinated.
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Using the Coordination Review Tool

After intelligent connections have been established between elements m linked

purpose of the Coordination Review tool to support the workflow when datum nr ^ .' t ^

elements are modified. ThÍs tool was designed to allow the recipient of linked data t-n ? .

how and when elements in host models are modífíed based on changes in the linkpr^i^0?
When a linked model is reloaded—which will happen automaticaUy when thehost^de

opened or when you manually reload the linked model in the Manage Linïs dÏaWklrno(iÍ
tored elements will check for any mconsistencies. If any are found/ you will seeawa^Ï'
message that a linked ínstance needs a coordination review. - - - aunng

Autodesk Revit

Warning - cai be igneret

Instarxe ofiink nesàs Coor&s^oïi Revigs

The Coordmation Review warning is triggered when any of the following scenarios occuÍ

A monítored element in the linked model is changed/ moved/ or deleted.

A monitored element in the host model is changed/ moved/ or deleted.

Both the original monitored element and the copied element are changed/ moved,
or deleted.

• A hosted element (door/ window, or operúng) is added/ moved/ changed/ or deleted iï
monitored wall or floor.

• The copied element m the host file is deleted.

To perform a coordination revíew/ swítch to the CoÏlaborate tab and click Coordination

Review > Select Lmk. After picking one of the linked models, you wÍII see the Coordmation Re^
dialog box, which Üsts any inconsistencíes m monitored elements (Figure 6.18).

Por each of the changes detected in the Coordination RevÍew dialog box/ one of the follcn

actions can be applied. Actions that result in changes to elements will be applied only to the)

model; they do not modify elements in a linked model. Also, not ali options are avaiÍable for i
monitored elements.

Postpone Takes no action on the monitored element and changes the message status só-
it can be filtered out or considered later.

Reject Select this action if you believe the change made to the element in the Ïinked file i
mcorrect A change must then be made to the element in the linked file.
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Accepts the change made to the element and updates the relationship.

unple/ if a pair of grids was 8" (200 mm) apart and one was moved to 12" (300 mm)
the change wouldbe accepted and the relationship would now consist of a dimen-

sionaloffset-

Modify/ Kename/ Move The command name changes based on the action. Iftíie^name ofthe

monitored element hás changed, the command reads Rename. If a column or levei is moved,

the command is Move. If a grid is changed or moved, the command is Modify.

New Elements A new hosted element hás been added to a monitored wall 01 floor.

g^lect this action to ignore the new element in the host. It will not be monitored for changes.

New Elements A new hosted element hás been added to a monitored wall or floor.

Select this action to add the new element to the host and monitor it for changes.

Delete Element A monitored element hás been deleted. Select this action to delete the

corresponding element in the current project.

Copy Sketch The sketch or boundary oí a monitored opening hás changed. Select this action

to change the corresponding opening in the current project.

Update Extents The extents of a monitored element have changed. Select this action to

change the corresponding element in the current project.

EjURB 6.18
. Coordination Review

)g box Usts
fonsistencies in

Einitoredelements,

^cordiïiition Reyiew

inhostprcij^t

Status, Cstegory, Riáe

MeMBgfï

'lêw/lJnFËEctyed

- •G"íls . . . . . .

Marrstgffï reÍstiVÈ porit^n of Srids

5 nd moved
[06-2-flrchttectutÊ.rA: Grids ; Grjd : ï • id

Qrjïts!Gt;á:2:ïCf17656;
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As you can see, Coordination Review can be a powerful tool to support the w

Process- Remember that such a tool may not be appropriate for ali elements at alTÍ^raíi^
example/insteadofcopyingandmomtormgcoluirmsandgrïds7itmay^^
monitor only grids because the columns placed in your host model will movp w,-ln to <
grids anyway. -""L"''c witnthe

Using the Coordination Review Tool—Exercise

In this exercise/ you will use two files that have already been linked togeíher with

elements between both files. You can download the files c06-Rev1 ew-Ar-chi.rvt or^??
Arch-Metr^.rvt(architecturalmodel)andc06-Rev1ew-Stru.rvt

Metri c. rvt (structural model) from íhis book/s web p age. In tíiis exercise,,you wíUd^Í
following: ---—/ ^..« vulciothej

• Modify eiements in the architectural model.

• Use Coordination Review to address these changes m the structuraÍ model.

Remember that you cannot have a host model and a linked model open in the sainp R J

session. To make this lesson easier, you can launch a second Revit session. Open cOG-Rp,^!
Arch. rvt or c06-Review-Arch-Metn'c. rvt mone session and c06-Rev-iew-Stru.''rv

cGG-Rev-iew-Stru-Metnc. n/t in the other. Then foiïow these steps;

l. In the architectural model/ actívate the Levei l floor plan and make the foUowir
modifícations:

• Move grid line F to the north by T-Q'1 (600 mm). You wül get a warning mês

'Coordinatíon Monitor alert: Sketches are different// Youcan ignore the warrSI
more on this later in the exerdse.

• Rename grid 6 to 8.

2. Save the architectural model and swítch to the structural model. Open the Manage LJ

window, select the linked architectural model/ and click Reload From. Browse tolhei

downloadedArchitechire file and reload it. Once the fíle is done reloading, you are

presented with the Coordination Review warning. Click OK to dose the dialog box/1
then click OK to dose the Manage Links diaíog box.

3. In the structura! project/ activate the Levei -l floor p1an/ and then switch to the Collat

tab and choose Coordmation Review > Select Link. Select the Unked architectural mo

4. When the CoordinatÍon Review dialog box opens/ under thc Message column/ you •

see a listing of monitored architectural elements that have changed under New/

Unresolved. Expand the tree in its entírety for both Floors and Grids,

Notice as you expand the tree that certain rows wil1 allow for you to specify an Actio|

There are three m total: one for Floors/ two for Grids. By default/ the Action listed
is Postpone.
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g. For each row with an Action option, click the Action field and apply the following:

• Sketches are different: Fostpone

• Name changed: Rename Element '6f

• Grid moved: Modify Grid T'

6. Click Apply and OK to dose the dialog box.

Notíce that Grid F hás moved up to be m alignment with the architectural counterpart/ Grid 6

been renamed to 8, and no changes were made to the structural slab due to the

postpone action,
Let's talk about the structural slab for which we postponed the actíon. In the previous

xercise/ you might have noticed the appearance oí a monitored floor sketch. Why did a floor

sketch change if you only moved a grid and renamed another? The answer lies in constraínts and

relationships. The exterior wall in the architectural model was constramed to be T-Q" (600 mm)

offset from grid line R When Ít was moved, the exterior wall was moved to mamtain the offset.

The sketches of the model's floor slabs were created using the Pick Walls tools, creating an

intelügent relationship to the wall. The modified grid affected the wall/ which modified the floor/
and the Coordination Monitor tools ensured that ali changes were detected and presented to you

for actíon.
As a best practice/ for any action during CoordÍnation Review that impacts geometry/ set the

Action to Postpone. Thoroughly investigate how the change in geometry will impact your

design, Once you have determined this/ go back to the Coordmation Review dialog and do one

of the following:

• If you agree with the change/ in the case of this example/ choose Copy Sketch to Tloor:

LW Concrete on Metal Deck/ as your action. This will update the geometry of the

structural slab.

• If you agree with the change to the architectural floor but it does not require a change to

the structural slab/ then choose Accept difference. This wíll create an offset relationship

betvreen the arcHtectural slab and the structural slab. Revit will consider the elements

coordinated and wiU remove the listing in Coordination Review.

• If you disagree with the change/ choose Reject as your action. This will cause a

Coordination warning in the architectural model when the designer reloads the updated

structural model.

In conclusion/ we/ve demonstrated the process in which Coordmatíon Review can be a

powerful workflow to monitor changes in linked files. To fully take advantage/ we recommend

that alÏ parüdpants involved in the coordination process are on-boarded with the toolset.

Using Interference Checking in 3D Coordination
In addition to asset management/ digital fabrication/ and cost estimation/ 3D coordination is one

of the most important uses of building information modeling. It hás enormous potential to

reduce the costs of construction through the computerized resolution of clashing building
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elements as well as exposing opportunities for alternate frade scheduling or prefah,;.

The key component to achieving 3D coordinatioii is Ínterference checking/ alsoknn^?ti01
clash detection. ~ -"-"vvn âs

INDIANA UNIVERSITY DEFINES CLASHES

As we mentioned previously in this chapter, not only are some building and facilita

BIM processes and deliverables for new projects, but they are also defíning how thesp TvrL Í

to be used. When you focus on interference checking, myriad potential clashes can bp/lJ^

a prioritized grouping ofbuilding elements. Borrowing from Indiana University's BIM St^.

Guídelines for Architects, Bngineers, & Contractors, the folíowing is an intelligent aüürn^il

organization of potential interferences. (Always remember that the priorities listed herp7^1

on the requirements ofone organization. The needs ofyour firm and those ofyour dientR ml3

LEVEL ONE CLASHES

Clashes in these categories are considered the most criticai to the coordination process. Tht

relate to systems or constmcíion techniques íhat are more costly to delay or reschedule:

Mâchanical Ductwork and Piping vs. Ceilings

MechankaÍ Ductwork and Piping vs. Rated Walls (for coordination cif dampers andl
mechanical equipment needs)

MechanÍcal Ductwork and Piping vs, Structure (columns, beams, framing, etc.)

AU Equipment and Their Applícable CIearances vs. Walls

Ali Equipment and Their Applicable Clearances vs. Structure

Mechanical Equipment and Fixtures vs. Electrical Equipment and Fixtures

Mechanical Ductwork and Pipingvs. Plumbing Piping

LBVEL TWO CLASHES

These categories of clashes are consiáered important to the design and construction process §|
less criticai than those designated as Levei One:

Casework vs. Electrical Fixtures and Devices

Furníshings vs. Electrical Fbítures and Devices

Strucíure vs. Specialty Equipment

Süructure vs. Electrical Equipment, Fixtures, and Devices

Ductwork and PÍping vs. Electrical Equipment, Fixtures, and Devices

Ductwork vs. Floors
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3VEL THRBE CLASHBS
; date a.e considera important to the correctness of the modela however, they will usuály

ïngeon a regular basis throughout the design and constmction process:

^ Casework vs. Walls

Plumbing Piping vs. Electrical Equipment, Fixtures, and Devices

Plumbing Piping vs. Mechanical Equipment, Futures, and Devices

ADA Clear Space Requirements vs. Doors, Fbctures, WaUs, andStructure

, THE INTERFERENCE CHECK TOOL

£^^ï^^^^=S^^S^S|=ÍÍJÍÊ§ÉL. ~
_.FOr.^pr^mTna^swTrks)7whTchTs7multifoTm^^ modd-reviewingtool withvarious

S^^r^^^^^:i=^^
ïs^^^ÏiÍÍÍ^^xs"Ï^SSS5£i^^ss^^.
oïe^orteddÏrectïy to the NavÍsworks format from the Application menu.

16.19
irdination model

i-isworks Manage
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Revit also allows you to link in Navisworks files ( . nwc and , nwd). We will rev

workflows in more detail in the next chapter.
le^tho

RÜNNING AN INTERFERENCE CHECK—EXERCISE

Lefs take a look at the Revit interference-checking process. For this exercise, you wil

download three sample files to your computer or network: c06-Interference~Arrh *^cl!

cOS-Interference-Mech, rvt/ and c06~Interference~Stru. rvt.You candowi

from fchis book/s web page. The sample files are already linked to each other usine rpia^

só be sure to place ali three files in the same folder. Then follow these steps:

l. Openthefile c36~Interference-Mech. rvt and activate the default 3D view.

2. Switch to the Collaborate tab, fínd the Coordinate panei, and choose Interferencg

Check > Run Interference Check.

3. When the Interference Check dialog box appears/choose cBG-ïnterference-;

available m the drop-down oí the Categories Prom Ust located m the left colurrm.

Structural Framing in Üie left column and Ducts in the right column (Figure

FIGURE 6.20

Select categories to be

included in an

interference check.

', iníerfêrencs ChecU

'Cai&gwKS fronfi

; c06-&itefference-Sínj,ryt

•C FÍc&rs

•• D Stnictural Cotümns

J Structura! Foundatfons

iS @ Síructuraí Framing
•• F. WafEs

Categortex from

lCtírreritProjecí

.. i3 AÍF Téfmirials

.. Cl Ductfíttíngs

?...^J HsíDucts

..'-1 Mechanka) EqLiipment

x

v ;

ínve
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4.

5.

^k OK to dose te Aalog box. ^ ^^^ ^^^ ^ ^^^ ^^^^ ^^^ ^

s^^sss^^^^^
ïiSh2hted in the 3D viev^. __^^«^a^^^
is tlig]

l2l
iüfa"

fcc^k^
tintïie

ice

Mow-

,® .orSteermg^

^s^^^^^=w
The Bottom Une ^ ^ ^ ^^ ^ .^umcation are the

l^:^u^r^^^^^S^?:^^^r^^s^Iforaudesi8"teams'
B1M planning document/ it is a ItíLull—;;J;^^ ^^on plan?

"M^ "Wha. are *. key elwts^;^^^ ,s te .W view
Co^eusin.UnW^^^^^S^^^^^^^^^^?;;w^cwn^
conr:r^'-^^^^e^.euseoH^.o^
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UseCopy/Monitor between linked models. The Coorriin.tinn ^^„

^^^te^=i^^fi^^^S^: ^est4
Sl"ppm! a^<or?wtotre¥ect;fc^^^^^^^^
data, perhapson a differen^cheduIetonïaÏJoZ^ZT^5 developin'Sft|

Master ít How can grids in two different Revit projects be related?

^3S^J^^^^^r-^^^^s^^^^^s^
Master H How do you fínd interfering objects between two linked Revit.

models?|

Ititeroperability: Working
Multiplatform

lê previous chapter/ we discussed working with others in an environment in which ali parties

Autodesk® Revit®; however/ often you/ll need to work with data from other software plat-

For example/ you may need to coordinate data from other disciplines/ reuse legacy data/

rrate disparate design platforms. There are several ways to use externai data within your

Revit model in both 2D and 3D. We will discuss not only the methods of importing and export-

inR data/ but also when to use each method and the reasons for using spedfic settings.

IN THIS CHAFTER, YOUTL LEARN TO

• Use imported 2D CAD data

• Export 2D CAD data

• Use imported 3D model data

• Export 3D model data

• Work with IFC Ímports and exports

Examining Interoperability on a BIM Curve
In 2007, McGraw Hill Constructkm published a study titled Interoperability in the Construction
Ïndustry. They reported that on average, 3.1% of project costs/ which potentially equated to

$36 billion in animal losses/ were caused by Ínsufficient interoperability between sofhvare.

Although the study is now a bit dated/ it underscores a problem that building information

modeling (BIM) still tries to address. Adequate mteroperability will help rectify the problem
Ulustrated in Figure 7.1, sometimes known as the B1M curve. Tn Figure 7.1, the downward spikes

in the lower Ime at the end of each project phase represent a loss of knowledge and acquired

data. This loss usually occurs when a project is exported from BIM to a 2D CAD format or is

printed to paper. Project data is then gradually reconstmcted m another software platform. The

upper Une represents a more ideal paradigm where data and knowledge are gradually increased

throughout the life of the project—a paradigm supported by BIM and full interoperability.
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FIGURE 7.1

The BIM curve shows

loss of data without

interoperability at

project milestones.
Source:?, Bernstein, Autodesk
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Although full interoperability between BIM platforms is the ideal scenario/ we rea1i.

even todaywith the maturity and adopüon of B1M throughout the industry, you arelikeÍvh3
working with constituents who are using 2D CAD or non^BIM 3D software. ' ~ ~ """^ lul

Inserting CAD Data
Although RevltProyides ample means to generate 2D documentation based on a rich multi"

dimensional (3D/ 4D/ 5D/ and só on) model/ there are a few real-world scenarios Ín which CAÍ

data must be integrated with the building information model. Such scenarios might incÏudel
foUowing:

•

•

•

•

Using CAD details developed within your fírm

Coordinating with other firms using CAD software

Converting projects from CAD to a Revit model

Using externai modeling tools for conceptual massing

Using complex component models from other software

üsing Predefíned Settings for Inserted CAD Data
When you are inserting data from a DWG or DXF file/ you can establish some predefmed settil|

to contrai its appearance wjthin the Revit environmení. Some settÍngs are controlled at the tim(|

you link or insert a CAD file/ but other settings can be configured more deliberately m saved

configuration files. The two ways you can configure this data are by mapping layer colors to
Revit Ime weights and by converting font types.

MAPPING LAYER COLORS

For inserted CAD files layers within the file are assigned a Revit line weight based on the weig|
assigned to each layer by the CAD software application that created the fíïes. If the layer line

are sct to Default in the CAD file/ they will follow a configurable translation template

^-4-rnaDS the layer colors to Revit Une weights. To access these settings/ select the Insert tab and

tÏ?L-thedíalog launcher at the bottom right of the Import panei. Doing só opens the Import Line

^feíghts diaÍogbox/ shown in Figure 7.2.

l^gsÊtíinglS
P.ÏDW/DXF
Ivffiigïit3

Impoit Lme Weigllt^ CNPregram FilE5Víutc>deït:\Re,it Ï()2(XSata'iitnport!inÉWeights"dwg-áeÍ3ylt,txt

tmïWesght

Í-fOTE: Thesc values orëf cppl,- to 'mss afiiHayers sei to l
unes and layers ïálh setiiney.-eighí ralus sresulwnatica!

JiE^^&tghtiri súu^ce
iêd si. ^.sí wuS^i.

As you can see in the title bar of this dialog box/ these settings are stored in a text file (TXT) in

the Data folder where RevÍt is installed. There are several predefíned text files based on interna-

tional CAD standards for layer color:

• AIA (American Institute of Architects)

• BS1192 (British Standard)

• CF83 (Singapore Standard)

• ÏS013567 (International Standards Organization)

CUck the Load button to select one of these predefined line weight templates or your own. On

the basis of the unique needs of some projects/ you might also consider creating customized

import setting files and storing them along with the rest of your project data.

DEFINING THE IMPORTED LlNE WEIGHTS TEMPLATE IN REVIT.INX FILES

You can define the default Import Line Weight template directly from the Rev-i t. -i m file. The file

location for the template is stored in the Revi t. -i n-i file in the foliowing category:

[Directories]
ImportL1newe-ightsNameDWG=< FuU path to TXT file >

If you are using any kind of automation scripts to set up standards, your Ímported Line Weights

template file locatíon can be written into the Rev-i t. l n-i file for alï your users. Doing só ensures

consistency for aU team members inserting CAD data into your Revit project. r
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MAPPING FONT TYPES

Anoto important aspect for inserted CAD data is the abiíity to map shape-based f^. Í

TrueType fonts Usually a remnant of older CAD standards based on graphicperfn^ts toJ

standard Wmdows fontsThe shxfontmap . txt file defines the mapping of TrueTv1^5 ü'1

substitutes for each specifíed SHX font Vou can fmdthÍstextmeatC:\PrnETr-^nypefontsÍ
RVT 2020'

If your firm frequenüy uses CAD data as an integrated part of your final docuinp

shxfontmap. txt file should be configured to map your standard CAD fontsto v^ . ati011

fonts used in a Revít project This file should then be copied to the workstations^

members using the software. Failure to do só may result in undesirable outcomes wh^alïl:l
CAD files in a worksharing environment. t-llusi^

Importíngvs. Linking

You can insert CAD data Ínto the Revií environment m two ways: importíng and Unkü
method hás advantages and disadvantages. —-r—""&""" uiiMng.^

Linking Almked CAD file in a Revit project is analogous to an externai reference i

an ^uto,CAI? p^oject when the original CAD fíle Ís modifíed, its reference is automaï
"? edín th.e Revit envíronment- Linkmg also allows Vou to easily unload or remove;

when it is no longer needed/ which will leave no trace of the fíle/s contents aiter remova

Linked data cannot be modified directly in a Revit project unless it is converted to an ir

in the Manage Links dialog box (Insert > Manage Únks) and then exploded. We discusstl
process in tine "Manipulatmg Inserted CAD Data" section laf-er Ín this cliapter. As an S

tive/ it can be modifíed in its original authoring application and then updated withm Rev!

Ï?o.rtín8.i_ s!ITÏr ?°.using ?e Lnserí command in Autodesk® AutoCAD® importing da|
íntegrates the CAD datamto the Revit project but does not allow the importeddata tobeÍ
updated if theoriginal CAD file is modifíed. In such a case/ the imported data woukThavl
be deleted and reimported It also does not give you an easy way to purge the layers/Íme-1

types/ and hatch patterns of an imported file Íf the data hasbeen exploded and then deleh

Unkíng is the preferred method for externai data integration. This is primarily because lii|
CAD files/ like linked Revit files/ can be temporarily unlinked and cleared out of active meml

This gíves^you more flexibilíty with the file. However/ too many linked files will make it slowj
to open a Revit project. For example/ ceiling plan fixture layouts may change with every desi|

iteration (where linkmg is preferred); however/ standard details that ali share a mmimal amoil

of standardízed layers, linetypes/ hatch patterns/ text/ and dimension styles míght be better
suíted as imports.

COLLECTING CAD LlNKS IN A LlNKED REVIT FltE

Another option to manage raany CAD references in larger projects is to create a separate Revit pf
ject that contains onÏy the inserted CAD data. íf the CAD data is pïaccd with the Current View Or^

option, you must use linked views between Revit models. Ifthe linked data does not use this optío|

lt wm be vif>ibl<2 like any other modeled element in a Ïinked Revit model. Refer to Chapter 6, "Worlttí
with Consultants," for more ínformation about Ïinked Revít models. l
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tions During Importing/Linking
íüs'Ilëvlra7econfiguTed the necessary settings for inserted CAD data and decided whether to
ÍAfter you ;^^vou"needto understand^certamoptions durmg the import/link pmcess.^We'11
l;iJIlPort°Í,rüreferredsettings for each of the options based on real-world situations in the
EdiscusluT^neÏnserted 2D Data" and "Using Inserted 3D Data."
|sectionl^^r"firstCAD file Ínto a Revit project/ switch to the Insert tab and select either l

T°rTncaTthe Ïmport CAD button. No matter which tool you use/ there^will be^ several
1 Ï^nt options at the bottom of the respective dialog box/ as shown in Figure 7.3.

i 7.3
;avai?for

link

Isyars^efïls! M vi

l^p<?rtünn^3 Ay^-Deisel •^ l^^OíjO-i

itoráng: AutB • Ongin ts Qrjgin

tece at; •s.aïell

QcxsntaViesa

Let's examine the mearúng of the settings in this situation.

^iew Only When thís option is selected/ the linked or imported filecanbeseen_

lïth'eviewm'which it was mserted and is thus considered a view-specific element. In a

^oAshanng-enabled project/ this data will be assigned^to the vieWs_workse^Mostí^you,,
3^walnttoücÍioose'fchÍs-option to limit the number'of views in whichthe referenced data wiU

appearïlf you need this data in other views/ you can copy and paste it from one view

to another.

i/ the linked file can be seen in ali víews/ mcludmg 3D/ elevations,

lndLsecïoïs.7naworksharmg-enabled proJect/ this data will beassigned to the active workset
ZbenefíUousmg Unks m a worksharing environment isthe abilityto crcate^workset_,^^ ^

^a:fkally"for"l£keddataand uncheckits Visible In AU VÍews option. The CAD files pl^^m
Si7mannerwiUnot-appear m every view but are available when you need them by adjusting

tihe workset visibility in the Visibility/Graphic Overrides dialog box.

Colors Colors don/t matter for CAD files being used as a basis to^create a Revit modela

ho"w"^er,u"sinïlnvertor Preserve may help distínguish the CAD data^mm the modeled^
eFemenïs durïg"theconversion process. Ifyou are"gomg to integrate the inserteddata m^

otheFeïementsTnyourproject for final design or ^"structiondocumentato^yo^U w^tto
select the Black And White option/ because printing from Revit is_most

yo7seeTswhatyouget). Read the section "Using CAD Data for Coordination" for more

detailed recommendations on this process.

Layers/Levels These options aUow you to import or Unk ali the layers, onlythelayers,v^ible
whenthe'CAD file was Íast saved/ or'a selected group of layers you choosefrom thelinke(

file in aseparate dialog box. (Layers is a DWG-based term. Revit supports the same tunctional-

ity with Leveis from DGN files.)

Import Units For CAD files generated in an origmal program (that is/UWGfromAutocAD
orDGN~from MicroStation)/ the Auto-Detect option works weU^fyou are Imkmg CAD

thathas beenexportedfrom a different program/ suchas aDWG file exported from Rhino/

you should specify the units relative to the respective CAD file.
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Positioníng To mamtain consistency in a multüevel project during a CAD-

tion or conversion process, you should use Auto - Origm To Origin or Auto - R. ^ ^

Coordmates. Origin To Origin will align the world coordinates origin of the CA^rh,a
project internai origm. Although Aufodesk hás stated Auto - By Shared Coor^, e 1

for use with linked Revit files, it can be used with CAD files if the rotation ofTritlS15!
becomes inconsistent usmg the Origm To Orígin option.

rue^

Place At This option is available only if Current View Only is not selected; it
levei at which the inserted data will be placed. SPecifie|

Correct Unes That Are Slightly Off Axis Selectmg this option automatically cor^^J
that are slightly off axis when you import or link CAD geometry. This option is se\^3
default and will help keep your Revit elements (such as walls or linework) that ï
lines from being askew; however/ you may need to consider this option carefuiïvTf.n.^1

data you are msertmg is intentionally off axis/ the corrections may lead to inaccurate ni

For example/ a site plan may have property lines that are a fraction of a degree fro~m'h3

orthogonal, but they must be mamtained for accurate building placement m your
Revit project.

OrientTo View This option can be used if True North hás been rotated away from

North. If that is the case and you are linkmg a CAD file into a view that is set to

deselect this option to align the CAD file/s World Coordinate System with True Norüi
defmed in your Revit project.

If you do check the OrÍent To View option/ the CAD file will align with Project North re!
less of the view orientation.

Manipulating Inserted CAD Data
Once you have CAD data imported or linked mto a Revit project/ you have several ways o|
manipulatíng the data to suit your needs.

Foreground/Background This settmg applies only to linked or imported CAD files pi,
with the Current View Only option. With the inserted file selected/ a drop-down menu •

appear in the Options bar só you can adjust whether the data appears above or below yí

modeled Revit content. You can also access this settmg in the Propertíes palette when th|
inserted fíle is selected.

INSERTING CAD DATA | 259

dose attention to this option when integrating 2D CAD data with an existing Revit

Fajj^_lsometimes linked or imported CAD data may not appearat ali until you set the
^tínn tciForeground because of floors or ceilmgs obscuring the 2D data.

oí Layers/Levels The layers or leveis withm a linked or imported CAD file can be

^secHn two ways/ the easiest of which is the Query tool. First/ select a linked or imported

filp: then, from the contextual fab m the ribbon/ select the Query tool and pick an object

intheCADfile.

;fr»< ModÍfySc07-P!sn01.dw3

Sring to Send to Odete
Ffoní ' Back Layerï

You will see the Import Instance Query dialog box (Figure 7.4). Usmg this tool/ you can hide
the layer or levei by clickmg the Híde In View button. The Query tool willremam active even

after you clíck any of the command buttons in the Import Instance Query dialog box, and you

must press the Esc key or click the Modify button to end the command.

IRE 7.4 ' import Ímtance Query

inng objects within
tedCADfile : | Psrameter

|8!ockName

tine

N/A

Oeiete Hiáeinview

The second way to make layers or leveis in imported or linked CAD files invisible is to use the
Visibility/Graphic Overrides dialog box by switching to the View tab and selectingVisibility/
Graphics from the Graphics panei. Once the dialog box opens/ select the Imported Categories

tab/as shown m Figure 7.5. Only the mserted CAD files tíiat are visible in the active view will
be listed in this tab.Expand any listed file to expose the layers/levels within that füe, and use
fhe check boxes to customize visibility of the Imk within the current view. This method is the

only way to restore visibility of layers/levels that were hidden with the Query tool.

CAD DATA IN FAMILIES

Remember that 2D and 3D data imported into Revit famiïies wiU be listed under the Imports In

FamiUes cafcegory in both the Visibility/Graphic Overrides and Object Styles diaíog boxes. They wül

not appear as separately listed files.
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FIGURE 7.5

ControUing visibility of
layers within

importedobjects

Eívtesetfiig:

Grapï.ovemde.s Tf you need to change the W^nce of the content within a lin

^TleÍCAD/Ál^youcanaccomP!ishthata"
T^change a CADme/s appearanc^throughout the project/selecffheManag
ríbbon' ^nd click object stylesm the settinSS Panel: s^^ ImportedoSecTstaT
(Flgure 7;6) andexPand any ofthe imported or linked CAD files"tochans'e'ÍheLOJor. Ii^
weight/Une pattern/ or material of the layers/levels within the referenceTfi^ Chau^un

p!opeÏesm therow of the mename does not affect the"contentsTnha7mel^o^
apply these settings in a specifíc view using the Visibility/GraphÍc~OvemdesdÍaÏ^^x'l

FIGURE 7.6

Changing the graphic
appearance ofimported

layers via object styles
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Although we do not recommend exploding CAD data withm a Revit project/ you

do it to facilitate the modification of such data. Lmked content must first be converted to

in arder to be exploded. You do this by selecting the Insert tab on the ribbon,

Manage Links from the Link panei/ choosing a listed link/ and clicking the Import

To explode the imported file/ select it/ and choose Explode > Full Explode or Partial
from the contextual tab in the ribbon. The lires/ text/ and hatch patterns will become

[ine styles/ text types/ and fill regions in your project. Remember that these types of

carmot be removed from your project via the Purge Unused command; you must

remove them manually.

TIPS ON IMPORTING CAD ÏILES

To minimíze t^le adverse impact of unnecessary styles and types carried into the Revit environment

vrith exploding imporfced CAD data, we recommend removing extraneous data in the CAD file before

íinking it. We suggest purging the file as weU prior to linking. Here are some general tips for

this workflow:

• If your import contains elements such as hatches or annotations not intended for use in the

Revit project, delete them before importing.

• Consider consolidating data within the CAD file to a minimum number of layers or leveis. Doing

só wiïl ease the process of converting to Revit Une styles if the file is exploded. This process will

aïso facílitate graphic ovemdes.

• ïf it is allowable within your workflow for the imported CAD file, import it into a family, and

then insert that family into your projecfc. This wiU not reduce the overall file size, but it will

make it a lot easier to fínd and manipulate should your imported CAD file need additional

changes. li will also gíve you some extra contrai over the graphic display of the imported file.

Revit doesn/t allow line segments shorter than 1/32" (0.8 mm). Although Ít might seem Uke

you wouldn't have a lot of lines that length/ many manufacturers' details contam small fillets in

sections and plans and will fali into this range. Take care when exploding these CAD details; the

very small Ime segments that fali within the minimum length will be removed upon exploding.

Note that manufacturing CAD files have the levei of detail needed to create the part (for exam-

pie, a window mullion), but are not necessary for architectural detailing. Because of this/ in some

cases it might be quicker to simply trace over the detail rather than insert and explode it.

Using Inserted 2D Data
In the followmg sections, we will discuss how to import 2D CAD data from platforms such as

AutoCAD (DWG) and MicroStation (DGN) or in the generic DrawÍng Exchange Format (DXF).
Vou can also use files from other software platforms/ but only if they are DWG/ DGN/ or DXF

formal Most comm.ercially available CAD programs are able to export in DWG or DXF format.
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2D CAD data can be used in three fundamental ways with respect to a buildii
r°Jecaplans/ ceiling plans/ or site plans:

• Using 2D data as backgrounds for BLVt conversion

• Integrating 2D data with the model

• Importing CAD details

Setting Options for BIM Conversion

On the basis of a common situation/ we will assume that 2D CAD data will be linlcor-i:.

Revit model to be converted into buildíng elements. Although the posítioning of the fnl°l
important/ the color and Ïine weights of the imported data are not. Í

To begin the next exercise/you will need the files c07-Plan01.dwg and cOT-Converç-J

Sta rt. rvt. You can download these files from this book's web page at www. w-i ley. com~/o1

mastenngrevit2@20. After downloadmg, open the c07-Convers1on-Start. rvt file ari
activate the Levei l floor plan. Then follow these steps: |

l. Switch to the Insert tab and select Link CAD from the Link panei. Browse to tiip fíi

c07-Plan01.dwg.

2. In the Link CAD Formats dialog box/ set the followmg options:

• Current View Only: Selected

• Colors: Invert

• Layers/Leveis: Ali

• Import Units: Auto-Detect

• Fositionmg: Auto - Origin To Origin

• Correct Unes That Are Slightly Off Axis: Selected

3. With those settings in place/ choose Open to link in the CAD file.

LINKING LARGE CAD DATA

Use caution when attempting to link or import CAD files with vector data very far from the.

Revit hás distance limitations of 10 miles (16 KM) from the origin poínt that—if exceeded|

result in a waming, as shown here.

fiee from lhe moátí piicht noí dispiaí
ie ussd.
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iing message mdicates that the software will automatícaUy use Center To Center position-

if the distance limitatíons are exceeded, This wiü preclude you from using the origin of the

ïd file for Origin To Origin placement. Íf you must link data that hás a physically large spatial

mirement—which may occur in proj&cts such as airports or master plans—you should separate

data into smaller poríions before linking. If the imported geometry is located beyond a 10-núle

Revit*s origin point, an alternate origin should be coordinated with your project team,

d ttie data should be moved closer to the origin.

Üsittg CAD Data for Coordination
n need to use 2D CAD data as an mtegrated component of your project coordination/ the

different Link CAD/Import CAD settings become important. The followmg are a few examples

of these project coordmation scenarios:

• Showing light fixture layouts from a lighting designei

• Integrating landscape design into a site plan

• Reusing existmg CAD data for a renovation project

Most of the settmgs and procedures for conversion apply to the coordínation process;

however, the color and the placement visibility will be different. Because this data will be

mcluded m the Revit output/ you will usually want the color option to be set to Black And White

in the options during linkmg. It is also likely that some sort of background plans will be exporíed

from the Revit model for use in coordination by one or more consultants using a CAD-based

program. The data returned in this process may still contain the background mformation

originally exported from Revit; thus, we recommend agreement on a standard that establishes

unique layers for the consultants' content. This will help you select layers to be loaded when

linkmg your consultants" files into the Revit project.

Use these options when linking CAD files mto a Revit project for plan-based coordmation:

• Current View Only: Selected if data is needed in one view; unselected if data is needed in

many views

• Colors: Black And White

• Layers: Specify (choose only designated layers to isolate consultants' content)

• Positioning: Auto - By Shared Coordinates

If Current View Only is not selected, the 2D CAD data will be visible m ali other views. This
could be a nuisance m víews such as sections and elevations; however/ you might fmd it useful to

visualize the data alongside the Revit model/ as shown in Figure 7.7.

Linking Details
Your company's CAD detail library does not need to go to wasíe when you start working in a

Revit environment. CAD data can be linked or imported into draftíng views, allowing you to

leverage the powerful view coordination tools within Revit. Entire sheets of CAD details can be

inserted to reduce the number of línked files you have to reconcile; however/ we recommend
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linkmg one detail into each drafting view and usirg the software's ability to automat.;.

manage the view references with callouts, sections/ and detail views. You mav als^ ^.. ^ •l

these draftmg views with a unique prefix to help keep track of where any linked CAn j 1

might reside. For example, a drafting view might be named CAD-Roof Deta-i \ 04 A7^':lTal

Chapter 4/ "Configurmg Templates and Standards/" for additional information on vi^ re^l

organization.

FIGURE 7.7

Existing 2D CAD data

integrated with the
Revit model

In Üús exercise/ you will create a draftíng view into which a single CAD detail will be lu

This view can be referenced throughout your Revit model using a section, callout, or elevatk

view with the Reference Other View option selected in the contextual tab of the ribbon, as si

in Figure 7.8.

FIGURE 7.8

Creating a view as a

reference to a

drafting view

Tobegmthis exercise/ openthe c07-Samp'Le-Bu1ld-ing-Start. rvt file. Youcan download

this file and the associated CAD file (c07-Detai l. dwg) from the book/s web page.

l. Switch to the View tab and select DraftÍng VÍew from the Create panei.

2. Name the new drafting view CAD Wall Detail l, and set the scale to 11/2" = 1"-0". Cl

OK to dose the dialog box. Revit will create and open the view just created.

3. Switch to the Insert tab and select Link CAD.

4. In the Lmk CAD Pormats dialog box/ navigate to the c07-Detail.dwg file and set the

followmg options:

• Colors: Black And Wlúte

• Layers/Leveis: AU

• Units: Auto-Detect

• Positioning: Auto - Center To Center

• Correct Unes That Are Slightly Off Axis: Unchecked

5. Click Open to complete the command. If you don/t see the linked detail in the drafting

view/ use Zoom To FÍt (or type ZF on the keyboard) to reset the extents of the view.

6. From the Froject Browser/ located under the Sections (Wall Section) node/ open the view

lÍsted as Wall Section/ Typ. Zoom to a portion of íhe view where a floor meets an

exterior wall.

7. On the View tab/ select Callout from the Create panei/ and select Reference Other View in

the contextual tab of the ribbor (similar to Figure 7.8). Choose Drafting View: CAD Wall
Detail l from the drop-down list. In the drawing window/ drag the callout rectangle

around the área where the floor at Levei 2 intersects the exterior wall,

8. After the callout is placed/ select the callout you just created and use the grip where the

leader Une meets the callout head to drag the callout head to the left. The result should

look like the image shown in Figure 7.9.

IFlGURE 7.9
Callout created to

reference a drafting view

containing a linked
CAD detail

Sim

Levei 2
16'-O"

•F

9. Double-click the callout head/ and you wiU be t-aken to the drafting view with the CAD

detail linked in the previous steps.
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CUSTOMIZING CALLOUTS

You also have the optíon to create your catlouts wíth nonrectangular shapes. Additi
•naüy,^

view you reference using the previous steps, you can change the target view afteïv^'

the callout or sectional reference. Simply highlight it and choose a new detail to refereT
Options bar. •ncefroj

üsing Inserted 3D Data
Now that we have discussed using 2D reference data/ we will show you how to use 3D.

data from other design software within your Revit project. There are many valïd reasnnoÏl

modelíng outside of the Revit environment, including software expertise, the avaiíabÍÏi^ ïr l
content/ and optimization of complex geometry. The followmg sections wiU explore sofífp0
situations in which model data can be shared behveen programs:

• Inserted data as a mass

• Inserted data as a face

• Inserted data as an object

üsing CAD Data as a Mass

In Chapter 10 "Conceptual Design/' you will learn more about harnessing the impressive

modeling toolset mRevit and Autodesk® Pormït® for conceptual design; however, the fastanl

flexible process of design may lead architects to a tool in whích they have more expertiseor l

comfort. This type of massing design workflow is supported in the Revit environment under l
following condiíions:

• Inserted model data requires solid geometry to calculate volume/ surface área/ and flool
área faces.

• Finely detailed complex geometry should be avoided because the Host By Face tools i
not be able to generate meaningful objects.

NOTE As of the writing of thís book, linking/importing SKP files in Revit 2020 is inconsistent. ThJ

are issues rationalizing geometry from SketchUp. The next exerdse works as intended in Revit 20lS

The^following exercise creates an in-place mass by linking an externai model—m this case/ i

SketchUp model. Download the files c07-SKP-Mass. rvt/ cOT-Mass.skp/ and c07-Mass-2.skj
from the book/s web page and follow these steps:

l. Open the project file c07-SKP-Mass. rvt. Activate the Levei l floor plan, and from the

Massing & Site tab (if that tab isn't available, you can turn it on under the File Tab ment

Options > User Interface)/ select In-PIace Mass from the Conceptual Mass panei. A

message window will appear/ notifymg you that Revit hás enabled the Show Mass mod|
You can dose this window.

•

•

•

•

•

•

Name the new mass family SKP Mass and click OK.

Switch to the ïnsert tab and select Lmk CAD from the Link panei; be sure to switch your

Files Of Type filter to ".skp files.

Navigate to the c07-Mass. skp file downloaded from the book/s web page and set the

followmg options:

Current View Only: Unchecked

Colo rs: Preserve

La yers/Leveis: AU

Import Units: Auto-Detect

Positioning; Auto - Center To Center

Flace At: Levei l

5. Click Open to complete the link process.

6. Click FÍnish Mass in the In-Place Editor panei of the ribbon.

7. Activate the Mass Schedule view from the Project Browser and observe the values for

Gross Surface Área and Gross Volume.

Now that a new mass hás been crcated/ you can assign mass floors and begm to see calculated

results in schedules of masses and mass floors. Calculation of volumes/ perimeters, and mass

floor áreas will work well Ír this workflow/ but be careful when using Ímported modeí geometry

with the By Face tools because face updates will likely be more difficult for the software to

mamtain than native Revit massing.
Using linking instead of importmg enabLes continued iteration of the form in the original

software. In the case of this example/ you can edit the original file in SketchUp, available as a free

download with a 30-day trial/ or you can try using the free web application—you can find both

at www.sketchup.com, Ïf you want to skip editing the SketchUp file/ download the file c07-

Mass-2. skp from this book's web page.
Tf you modify and save the original SKF file yourself/ save/ dose, and reopen the Revit project.

As an alternative/ open the Manage Links dialog box/ select the SKP file/ and click Reload. If you

want to use the altemative file downloaded from the book/s web page/ use the following steps:

l. From the Inseri tab of the ribbon/ click Manage Links.

2. In the Manage Links dialog box/ switch to the CAD Formats tab/ select the SKP file, and

click the Reload Prom button.

3. Navigate to the file c07-Mass-2. skp and click Open.

4. Click OK to dose tbe Manage Links dialog box.

With the modifíed mass loaded, activate the Mass Schedule view and notice the changes of

Gross Volume and Gross Surface Área.
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Using CAD Data as a Face
Similar to the data-as-mass workflow, externally modeled data can be used as a

more complex forms. An example might be the need to generate a complex curved rr.^í ^

We wiU demonstrate this workflow using Rhinoceros (commonly referred to as Tü-iinn\ L •I

McNeel (www. rhjino3d.com) to generate a shape, link the shapeinto the projectas ac.^ ^ ^

create a roof by face on the shape. (If you have Rhino, feel free to foIÏow the exai

however/ for the later Revit exercise, we have provided ali necessary files.)

As shown in Figure 7.10, a compÍex surface is generated in Rhino by drawing hvc

usmg the Extrude Curve Along Curve tool. Note that some reference geometry was exnnli s

from a Revit model to DWG and Ünked into this study in Rhino.

FIGURE 7.10

Curves for â complex

surface in Rhino

A flat surface model is enough to generate a roof by face; however, it may be diffícult to si

the imported surface/ só use the Extrude Surface tool to gíve it a thickness. Once t-he surfaceisl

complete (Figure 7.11), select only the double-curved geometry/ choose File > Export Selected'1

Objects/ and choose the . s a t filenarne extension. SAT will generate the cleanest geometry for

curved solíds ana surfaces. Note that Revit does have the abílity to directíy import (not link)

RhÍno forms without fírst having f-o perform an export; however, directíy importing native

files can be unreliable when preserving the form of the geometry. Because of the geometry

inconsistency/ we are going to be usmg a SAT file for the exercise. This wiíl make the exercise

more generic and still illustrate a workflow that is accessible to other áesign platforms

beyond Rhmo.

FIGURE 7.11

Completed complex

surface in Rhino
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shown m Figure 7.12.
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FlCURE 7.13
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CAD Data as an Object
mother derivation of the reference data workflow supports the use of CAD model geometry

;ecLfic ínstances of buiidíng components. Examples of fhís scenario nüghf Ínclude a complex

structure being designed in SolidWorks or a building/s structural framing bemg modeled
in Tekla Structures, The worküow is again similar to that of using CAD data as a mass or face;

c, the file format will help you control the component s visualization. In the previous

•íse/ we used a SAT format to transfer complex curved geometry from Rlüno to Revit;

r/ a limitation of a SAT fíle is that the geometry contains orúy one layer, making it

)ssible to vary material assignments for different components of the design. We recommend

a solids-based DWG/ DGN/ or DXF file format/ which wíll maíntaín a layer structure in

most cases.

In the following exercise/ you will create an in-place structural framing component that will

act as a placeholder for a consultanfs structural model, which is in DWG format. You will be

usingthe fíle c37-3D-Structure.dwg, whích you can download from this book/s web page.

l. Downloadand openthe file c97-Fram"ing~Start. rvt from the book/s web page. Activate

the Levei l floor plan.

2. Switch to the Architecture tab and choose Component > Model In-Place. Set Family

Category to Structural Framing and click OK.

3. Name the new in-place model DWG Structure.

4. From the Insert tab, select Link CAD.

5. Change the Files Of Type option to DWG Files (*.dwg) and navigate to the file c07-3D-
Structure.dwg.

6. Set the following options and then click Open:

• Currcnt View Only: Unselected

• Colors: Black And White

• Layers/ Leveis: Ali

• Import Units: Auto-Detect

• Positionmg: Auto - Origm To Origin

• Place At: Levei l

The DWG file provided is actually a sample Revit file that was exported to DWG format
(Figure 7.15). Models may be provided in this format from any number of other design
applications such as Autodesk® AutoCAD® MEP or Tekla Structures.

7. Click Finish Model in the In-Place Editor panei to complete the process.

Activate the default 3D view/ and you should see the entire contents of the Imked CAD model

(Figure 7.16). Because the linked content was created as a structural framing model/ the linked

data will be displayed similarly to any other structural frammg element. Examine the linked

model in different plans and sections to observe this behavior.
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FIGURE 7.15

The structural model

displayed in AutoCAD

FIGURE 7.16
CAD-base d structural

model linked into a

Revit project

ien you are using linked model data for custam components/ the consistency of the data

Ínto Revit from other programs depends on the ability of that software to generate

inized mformation. Some programs use layers, and some don/t Recognizing this difference

you the best opportunity for success in coordination through interoperability.

^ortóng with Other Data Types
ivit hás the ability to utilize file types from Autodesk® Navisworks® (. nwc and .nwd)and

rmlt- Navisworks files are key for model coordínation for disciplines that are not naüve Revit

t. While Navisworks focuses on the resolved buildmg design (it is typically incorporated

>ar the end of the construction document phase)/ Formlt can mtegrate at the begirming of the

:ocess. Formlt (f orm~\ t360.autodesk.com) is an early design tool/similar to SketchUp.

yfe will review workflows with both tools.

Working with Navisworks Files
You can now bring Navisworks files directly into Revit for coordination and visuaüzation.

Navisworks is typically a tool employed by contractors and used to combine a variety of model

for construction coordmation. You can fínd out more about Navisworks from

Autodesk/s website:

www.autodesk.com/products/navisworks/overview

In the following exercise/ you will insert a NavÍsworks model into your Revit file. For the sake

ofthis exercise/we have converted the c07-3D-Structure.dwgfileto anNWD file. Wewill

insertthis file Ínto the c07-Fram1ng-Start. rvt fÜe for structural and architectural coordmation.

l. Open the cOT-Frannng-Start. rvt file you downloaded earlier and openthe

Coordination view from the Project Browser.

2. On the Link panei of the Tnsert fab/ you'11 see a button called Coordination Model

(Figure 7.17). Choose this tool to insert a Navisworks model.

gGURE 7.17
ge CoordÍnatíon Model

Eol on the Insert tab

link Link Link
Íevit EFC CÂD

If you/re not seeing the model as part of your 3D view/ you forgot to uncheck the box for

Current View Only in step 6. If that is the case/ you'11 need to either undo your way back or

unlink and relink the CAD file.
Using iinked models in DWG/ DGN/ or DXF format also allows you to modify the grapíúl

representation of the elements within the Revit environment. To adjust these settings/ folloWi

these steps:

l. Select the Manage tab, click Object Styles, and switch to the Imported Objects tab.

2. Find your línked file, expand it to expose the layers or leveis included in it, and nioa»

the graphic settings as desired.

3. Selecting the Coordination Model tool will show you the Coordination Model dialog box
(Figure 7.18). This dialog box operates similarly to the Linked Files dialog box. For
Positioning/ use the drop-down menu and select Origm To Origin; then click the Add

button at the bottom left and navigate to the c37-3D-Structure . nwd file you down-

loaded. Select the file and choose Open. With the fíle mserted/ it should look like

Figure 7.18.

Once the model is inserted, you can interact with it in many of the same ways you can with a

RevÍt model. You are able to view different floor plans/ cut sections/ use crop regions/ assign a

phase, and só on/ in arder to use the Navisworks model for coordination or documentation. Once

the model is imported into Revit, it will mamtain any of the element colors you assigned it in

Navisworks. Figure 7.19 shows the model inserted into Revit



274 | CHAPTER 7 INTEROPERABILITY: WORKING MULTIPLATFORM

FIGURE 7.18
Tïifi Coordmation

Models Management

dialog box lïadeá l Q.'i Mi
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FIGURE 7.19

The Navisworks model

linked into a

Revit project

Working with Formlt Files
Autodesk Formlt is a conceptual design too! similar to SketchUp/ with the difference bein|
SketchUp is plane-based and Formlt is a solid-based modeler. This means you can also t£

Formlt models directly to a 3D printer.

Formlt was originally designed as a web-based tool and saves your content by default|

A360 site (autodesk369. com). With a paid Pró subscription/ Autodesk provides a desktoi
version cf the applicatíon/ which allows you to work with bigger models. The Pró subscri^

also provides additional functionality to include connectivity with Dynamo/ energy anal^
Autodesk Insight/ solar analysis/ connectivity to a cloud version of the Autodesk M.ateríc

Library/ and real-time collaboration. While Formlt Pró hás these features/ we are going to|

on Formlfs interoperability with Revit. We leave it to you to Ínvestigate Formlt/s other fej

Figure 7.20 shows the typical Formlt mterface. For this example/ we have re-createc

c07-Roof-Face file in Formlt and assigned a material to it. Via Formlfs export commant

have exported the file as cOT-Roof-Face.axm, whichisFormIfsnativefííp format.Youc^

download this fíle from the book's website.
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^73a
^tinterface .? ^ •:. -•<L

Formlt hás the unique ability to interact with Revit as a family file. Essentially/ an AXM file is
converted to an RFA file when it is Ímported into Revit. Alternatively/ you can export content

from Revit to an AXM format to continue workmg directly with it in Formlt. While there is no

"live linking" avaílable right now between the two toeis/ it is easy to use the import/export

mechanism.

You can ünport Formlt models to Revit or export to Formlt from the same menu in Revit. On

the Add In tab from the Formlt Converter panei/ choose the Import Formlt To RVT drop-down

(Figure 7.21). From here, you can browse to a local or A360 Formlt file to import into your Revit

model or export to the same locations from Revit. To view the roof face geometry that was

imported/ switch to a 3D view. Depending on the Revit template from which you started the file/

you may need to go to VisibUity/Graphics Overrides and check the Mass category.

ÍGORE 7.21
|e Formlt drop-down

inu in Revit

Convsrt RFAto F&rmit i

Conveit SKP to Formft

!mpMtFornt!ttoRVT

Reíoad Fsmilies

Exporting CAD Data
Just as significant as importing data, the ability to export Revit data for use by others is equally

important. We will now examine various processes for exporting data from yoür Revit project to

other formais. To achieve your desired results when exporting/ remember that exporting from
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Revit is essentially a WYSIWYG process. For example/ exportmg a 3D view will resn1+ ^

model/ exporting a floor plan will result in a 2D CAD file, and exporting a schedule \vii
adelimited file thatcanbe usedin a program such as Microsoft Excel. UI1esi

We will first review the settings to be configured for the exporting process. These rnoH. l

siinilar for almost ali exports and will be referred to in subsequent sections. The

exporting CAD fíles from Revit includes two basic steps: create a list of views to be

define the settings in an export confíguration. ";u,;

Preparing a List of Views for Exporting
The first step to any CAD export is to establish the set of views to be exported. You

file cOT-SampT.e-BulT.ding-Start. rvt forthis section's exercises. The followmg steps wi1

you through the process of creating a saved list of views for export:

l. You can find ali exporting commands in the File Tab menu when you click the

flyout. You may need to scroll down this flyout menu to access ali the export cornin;

available for use. Prom the Export menu/ select CAD Formats > DWG.

2. Vou will first see the DWG Export dialog box, as shown m Figure 7.22. The Export

drop-down list is set to <Current View/Sheet Only> by default. This is where you wcn

select predefíned lists of views to be exported from your project.

FIGURE 7.22
First view of DWG

Export dialog box

DWS Expcrt

S^ectEimwtSêti^!

Sele^f ^É'^ And Shee^s Tu Eiipürt:

Pr^v^ft'cf ^rfiftiEïg ^ew: ^lARA El<í!'d$eTHJ
Exp<xi; <cuTiïnt láew^ihwt:

£) G

Mastering RevEt
Arehstecture'

37.23
^vailableexport

itithe"loc

4. From this point/ you can either use a temporary in-session set or create your own named

set. We will continue these steps by creatmg a new named set só you can export the same

sheets later without the additional setup. Click the New Set icon above the víew list/

shown in Figure 7.24, and name the set FLANS. Click OK to dose the dialog box.

ÊlIfiüRB 7.24
:reatinganew

iort list Show in itefc s Al vle?s aid sheeís in the f

tTíD^ ís :"

Dfaftind V(ew: MARA &íârcis

x

USIKG IN-SESSION LlSTS WITH WORKSHARING

Be careful when using an in-session Hst for printing or exporting on a worksharing-enabled project.

If two or more team members worHng on the same Revit project attempt to use the in-session set,

you may receive errors about the workset not being editable. Instead, always try to use predefined

lists for exporting and printing on worksharing projects.

3. Begin to create your own list of views and/or sheets to export by choosing <In-Session

View/Sheet Set> from the Export drop-down list/ shown in Figure 7.23.

5. To begin adding views and/or sheets to your new export set/ from the Show In List

drop-down menu/ choose Ali Views And Sheets In The Model.

6. Click the Check None button to clear any exfcraneously selected views and then find the

floor plans with the A- prefíx. Select these views by checkmg the boxes next to the views

in the Include column.

Remember/ you can sort the list by clicking any of the list headers (Figure 7.25).
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FIGURE 7.25
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7* fornow/ wewiu simply end this exercise by saving the líst of views for later. C^
Save Set & dose button, and the DWGExpJorTdÍaÍ6ogbcoJx°wïuvdeo^s 1°I Iater' a":kj

8. Save the project file before beginning the next exercise.

..No.wültyou have createda saved list of views for export/ they wiU be available for.

^lTCZ^l°uca^crTt^asma"ylistsasyou-neeï"^
S^heDWG.E^tdï°gb^
settmgs for exported DWG files. --—v

Settings for DWG Exports
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i«?.26
fnW<3/ÜXF
^dialogbox

MïíiifyÜ^S/O^F EspQrt Sritíp-

W&rf. EwjrfSê^çí Ctí^fS 50&Ã

,&ipoií cátt^s?

As you can see, a number of opporhinities for customization are offered in this dialog box.

First/ you/ll notice at the left side of the dialog box a list of export setups and icons similar to

thosefound m the main DWG Export dialog box. Use these icons to create/ duplicate, rename/ or

delete export setups m your project. Let/s take a look at some of the other export settings in

greater detaü.

LAYERS
The Layers tab was shown previously m Figure 7.26. It contams many options to completely

customize the export of object styles to layers. Lefs examine each of these setüngs more closely.

Export Layer Optíons

At the top of the Layers tab is a drop-down that allows you to specify the overall behavior of

exported elements. This settmg accounts for any graphic overrides that might be applied m a

Revit view. For example, the Linework tool might have been used to modify the edge of a wall to

a dashed Une. These options determine how that override will be exported to a CAD format:

Export Category Properties BYLAVER And Overrides BVENTITY This option will export
unmodified elements to their respective layer assigmnents, and their properties will remam

assigned to the layer. If an object or part of an object hás been overridden/ the overridden

element will still be assigned to the respective layer, but the graphic override will be applied
directly to the entity. In the wall example noted previously/ the wall edge would still be

assigned to the A-WALL layer but would have a DASHED linetype instead of a BYLAYER

assignment

Export AH Properties BYLAYER, But Do Not Export Overrides If the recipients of your
CAD file will use scripts or macros to enforce their own graphic standards to the exported

data, select this option. Using the wall example again/ the wall elements would be assigned to
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the A-WALL layer; however/ the dashed Une overrides would not be exported. Th;,

export is usualÍy appropriate for engineers who need to use architecturaí plans as^^.

ali

information and thus will override ali elements to halftone.

Export AH Properties BVLAYER, And Create New Layers For Overrides This fh
will assign default objects to layers based on their categories; however, any elemen+o \^

graphic overrides will be assigned to new layers that are subsets of the original

we continue with the prevíous wall example/ the umnodifíed wall elements wiU be

to the A-WALL layer/ but the overridden edge will be assigned to a new layer such

A-WALL-3/ where the properties of the element are ali BYLAYER and the new IE

the dashed Imetype. In our opinion/ this option is less usehil because there is no (-•nn^i

over the naming of the new layers/ thus creating potential confusion for the recinif

exported files.

Load Layers From Standards

Several exporting templates based on the industry-standard layering guidelines are ii

wíth the Revit and can be applied in the Load Layers Prom Standards drop-down (Fij

These layer settings can be used as a baseline; you may still need to make modifications to

settings to accommodate your project standards. Once you have configured the export settii
click Save Set & dose in the main DWG Export window. The layer settingg for DWG

now be part of the Revit project file.

Tf you wish to re-use the DWG export settmgs that were defíned for other Revit projects,

the Transfer Project ëtandards function to copy the settings over (see Chapter 4/ //Confígurin^

Templates and Standards"). In the Select Items To Copy Window/ be sure to check DWG/D)

Export Setup Settings.

We realize that transfemng settings from. one project to another can be complicated/ and

because of this we recommend the following:

• Create a standalone project file that contains the confíguration for ali your layer settmj!

This fíle can be used as an export layer template to copy layer settings to other Revit

projects through the Transfer Project Standards funcíion.

• When transfemng export seítings/ in the Select Items To Copy window, uncheck ali ite

except DWG/DXF Export Setup Settmgs. This will ensure only the settings that are

needed are copied.

• For any future changes to export layer settmgs/ determine if the change needs to be

reflected in the standalone fíle. If yes/ use the Transfer Project Standards to update the

Revit project file that contains your export layer tempíate.

FICURE 7.27

Industry-standard

layering conventions can

be applied to

export settíngs

EKportcategorv propertieE; BYLA^R and ovs-rides BYErTOTy
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, and colors can also be customized by directly editmgthev^esmti.eLay^s tab
La^^DW/DÏFEx7ort"Setup dialog box. Each category and subcategory is capable of

l iïl?e.lrÍpntcoïor and layer names. .... ._ . __.._^ ^ ^^ ^.
l ^epen.TnldÍ*f^s"canbe appÏÍedto any or ali of the model categories for ^port.Todo_Üus^

.^^^y^Uo^e^ column for any offceUstedmodel ^^gones^to ^
eithff^^ ^^pe^
theuA^nZL^d7EdÍt"La7eTModite box (Figure 7.28). Here you can assign modifiers

^Status/ Workset/ View Type, or user-customized flelds.
such as
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LlNES
Switch to the Unes fab in the Modify DWG/DXF ExportSetup dialog box/a^dyou w^fi^^
^dZnZecttiIngs°fo7assignmgRe^^^^
SsT^sattthítopoTth^b7is to assignthe linetype scale Ínthe exPor^dc^me^^^
^Z^^^^^d;kp^^e,^e:o^caldLu^^De^^^
^nïe cTangeïbyTheredpientof the exported files/ só it is commo^o ^eth^MOJ1^^
se^g^Jy^dervTe^exports^^^ plans or elevations, and the Paperspace setting for

sheetviews. . .. , . „ .. ^..^.

^ Ü^ain list within the Unes tab, any Une patterns defmedinyourRe^t P^t^ b^,
assÍgn^ ;^'sprificÏA&teedUn.type:The clefault ""«•We,deflmtums^ ^^de^^;
RaeZ^tïtZb^7hang^wÍthth7co^^ buttons above the Ime patternslist. The default
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settmgfor exPortin§Ime Patter^ is Automatically Generate Linetype/ whirh ..,

gmpMc pattem but will not integrate welÍ wÍthanyotherCAÏÏsof^arev;^wul reP^|
require additíonal modification by the recipient. - ~ " "tc CXPOrted j

FlCURE 7.29
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FIGURE 7.30
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. 7.30 shows a few of the Revit fill patterns to be mapped to a respective pattern from the

l. FgAnoatterndefinition. . _ .^ .,
wto^r Stomizations can also be made for fonts in the Text & Fonts tab/ and in^e^Colors

5ÍÏUa^hoose to either use specific layer-based color IDs or use the true color RGB values

3udïyour Revit project. Lefs take a quick look at the remaining tabs and their importance.

Sfítl

^líds tab/ you have the option to select either Polymesh or ACIS SoUds for exPorting 3D
lFuor"deaner solid geometry exporting/ we recommend the AGIS Solids option; however/

Ïf^wiiu^elyresult in a larger me slze UPOn export'

ÜNXTS & COORDINATES
: important settings is Coordinate System Basis/ which can be found in the Units

w ^Ínateïtab7Thisoption wUl affect the ability of your exported files to be properly aUgned

^tí^therpTOJect files. Refer to Chapter 6 for more information on using shared coordinates.

l GENERAL
the General tab (Figure 7.31) contains some additional options such as assignma

E nwïlottable layers/ exporting space boundaries/ and default export file options.

Mesllíy CïtW/CXF Elpert Íatup

hil options allow • ^^^
ïï customization of

»orts.

in^oLÜC^yirs;

3^^^veis

^tncfcuT-ftfsren"

^JPn*SP-/aooï^íSt

^^ÏCTÏ^Svï

iSfÍinfltfl

;':1 Ü

At this time/ you can click the Cancel button to dose both active dialog boxes. In the next

section/ you wilÍ return to these settings and save a configuration to be applied to the

exportprocess,
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Exporting 2D CAD Data
When you are collaborating with others who require 2D CAD/ developing a planno^ •J

wíll allow you to share your Revit data more efficientiy and consistently. We hií

determine and document the scope of data to be shared, the schedule b\t ^i.

wíll be shared (when and how often), and the software platforms to be used on. a n^

that you

wíll be shared
Projectj

aspects should be compiled in a BIM execution plan/ as explained in Chapter 6.

To facilitate the setup and ultimate export of plan data, you can create copies

and ceilíng plans with a standardized naming convention in your Revit project.

easy to recognize/ and they help in buildíng the export list. Figure 7.32 shows a seríf

cated plans thaí have been created and assigned to the floor plan type namec

name conforms to the naming convention specifíed by the Urúted States Natii

(www.nat-ionalcadstandard.org).

FIGURE 7.32

View organízatíon for

plans to be expor te d •Arcbiteefurei PJan

. HoorPIsn; levei 1

. FÍoorPiafi;Level2

FJoor Pian; Le^'el

iFloor Plan: levei 2 - Export

a Pia n
FkiorPtan:Sitâ

In the following exerdse/you will continue to use the c07-SampT.e-Build-ing-Start.rvl

project file while using the saved list ofviews you created in the //Preparing a List ofViews!

Exporting exercise:

l. From the File Tab menu/ click Export > CAD Formats > DWG. In the DWG Export di|
box, make sure PLANS is selected in the Export drop-down. Click the Modify Export|
Setup ellipsis button (three dots) at the top of the dialog box.

2. In the Modify DWG/DXF Export Setup díalog box/ select the New Export Setup buttc
from the bottom left to create a new export setup. Name the new export setup Brítisl

Plans witin Phase.

3. In the Layers tab/ set the Export Layer OptÍons drop-down líst to Export Category

Fropertíes BYLAYERAnd Overrides BYENTITY Locate fhe Load Layers From Stand^
drop-down Ïist and select British Standard 1192. You will receive an error message stat

that loadmg these settings will rep lace your previous settings. CUck Yes to accept.

4. WhilestillintheLayerstab^clickfheAdd/EditModÍfiersForAllbutton. IntheAdd/I
Layer Modifiers dialog box (Figure 7,33), add the (Phase Status} modifíer from the list-
the left to íhe Modifíers Added list at the ríght. Next to {Multiple Categoríes} in the
Separator column/ add a hyphen. The prevÍew above should now read {Multiple

Categories}-{Fhase Status}. Click OK to dose this dialog box.

EXPORTING2DCADDATA 2ft5

1.7.33
|base;
i to aÜ

ïê-

Status}

5. Switchtothe

clicking Ae ra
dialog box.

SSSSSÍ3SSSSÏSS1'

6.

7.

8.

dialog box. ^ ^ _^_ ^ ^^ FYnnrt CAD Forinats-Save

. ^-Ne^t^t;Gt^S^^^=:t^sh:t:mswül
Ïo^getFolder dialogbox/ se^heN^mmg,_a^^u^

^S^^^^tonooTna^~rp^^ ^^ ^tting. Although
. ;::^^^^^^^^:?s^^

thissetting does not affect this exerase/ we ^^^^^ ^ ^ ^^ ^
^eZwopr^e location ^^m^01 your network ía the e'Torte

8-^^^^^^^^^^^^^^^^expo^ore
unfortwatd^^^tz^^^^^^:nb;weítorcmove

toone view in abatch Proces^Th^^^T^orna\^^ optlon-

'^i^^ÊSSSSSss^^
Exp^D^t^g^^^^ S^P:rónë?et';;e^3^S:Sï5S'^^^^s^
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ured as externai references (Xrefs) in the exported sheets. If you also have oíher

mto your current model, they too will be exported as separate CAD files and cnnfír^!

in the exported files.

We recommend that you deselect the Externai Reference optíon durirtg exporüi

absolutely necessary. The exporting process will result in fewer files and

predictable results for íhe recipients of your exported data.

Exporting 3D Model Data
In the previous section, we showed you how to export 2D views to CAD formats. wh;,

support more traditional collaboratíon workflows. You can also export your Revit nm;<

model m several formats for use in other modeling software. A frequent destinatioi

is Navisvrorks for its enhanced coordinaüon wíth contractors during construction. Thi<

flow is supported by a free Navisworks plug-in for Revít that wül allow you to expoi

models as NWC files/ which Navisworks uses. More generic exports in DWG/ DGN.

formais can províde numerous opportunities for you to become more creative with the

tion of your designs.

Exportíng to Sketchüp
Previously in this chapter we discussed using SketchUp for conceptual building massing si

These studíes were imported directly into the Revit environment for further developmenti

true building information modeÏ. Revit model data can a1so be exported via 3D DWG to

SketchUp/ where visualization shidies can be conducted on an entire project or even a siml

wall section.

In the following exercise/ we will export a wall section study froin the Revit enviromní

SketchUp using files you can download from this book/s web page. To complete this exerci

you can either download and install the desktop version of SketchUp or use the web-basec

version of the applicatíon from www. sketchup. com. Please note/ some of the SketchUp fea|

in the tutorial are not accessible without a paid subscription. If you are using SketchUp for|

first time/ then no worries; there is a free 30-day trial that hás full functionality.

To begm the exercise/ follow these steps:

l. Openthefile c07-Sketchup-WaU-Study. rvt.

2. Activate fhe Default 3D view and enable fhe Section Box option in the Properties pi

for the view.

3. Set the detail levei of the view to Médium or Fine.

4. Select the section box in the 3D view/ and shape handles will appear on each face. Gj

the shape handle of one side of the section box parallel to the vertical edge of the WE

sample/ and drag toward the wall until the section box intersects the wall/ as showi

Figure 7.34.

You should see the layers of the wall structure exposed.
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.34
iboxto

i:es<
belayers

5. With the section box still selected/ right-click and choose Hide In View > Elements.

This will prevent the section box from being exported.

6. Click the Kle Tab menu and select Export > CAD Formats > DWG Files. Set the Export

drop-down Jist to <Current View/Sheet Only>.

7. Click the Modify Export Setup elíipsis (three_dots)button to°PenfcModlfyD^DX^
7'^^SPb°orxt.TnZCSyD'^^^

Mlï^L^d7et"t6heoptíonto Polymesh. CUck OK to dose the Modify DWG/DXF

Export Setup dialog box.

8. Click Next and set the Files Of Type drop-down toAutoCAD2018DW Files. Select a
rocatí^on"yourcomputer or network and then clkk OK to save the file.

9. Launch SketchUp and create a new architectural model. Choose File > Import.
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10. Switch the Files Of Type option to AutoCAD Files, navigate to the file;
click Import. You'H see an Import Results window; click"Close to view^7a ln steP i
imported model. • "^

11. Switch to the Select tool/ select the entire DWG import, right-dick/ and choos

__This.ÏU al,IOW you!° dírcctíy edit the elements in the SketchUp environment. nZl
nents within^he exploded model may need to be exploded again.' ——• ^mer ^

Once the DWG model is loaded Ín SketchUp/ you can use"the Paint Bucket toe

materiais to mdividual components/ use the Push/Pull tool to hide or exüosp1^Luapply J
ronstruction/ and use the line tooís to customize the profile of the revealed lavPi/^ZU^me 1
Figure 7.35. ^ "~~" ^ ""/ cly shownl

FIGURE 7.35

Completed wall study
in SketchUp

3D EXPORTS BY LEVEL

Effertm; coordination between Revit and AutoCAD MEP frequentíy relies on the exchange of 3.1

DWG files of limited scope^with respect to the ovemll project. MEP engineers using AutoCAD MEJ

wiUusualïy manage their BIM wíth one model file per levei. Even though the enílrearchítectuïJ

model can be exporíed to a single DWG model, they may not be able to reference such a large moá|

efficiently. The good news? Your Revit project can be set up to achieve this bycreating 3Ü> views witi
section boxes for each levei. -\

Begin by creating^a series of floor plans designed for exporting (discussed previously in this cha|

ter). In the View Range settings for these plans, set the Íop value to Levei Above, Offset O and th|

Bottom va!ue to Associated Levei, Offsefc: 0. Create a 3D view for each levei required in the projec|

and rename the views according to your standards. In each duplicated 3D view, right-click th|

iCvhe, selecfc Orient To View > Floor Plans ana choose the correspondmg floor Plan wiül the

.JSedview range, This series of 3D views can be saved in an export list and batch-exported to 3D

^^r.'-,/Men needed for collaboration, as shown here.

Using IFC Interoperability
Industry Foundation Classes (IFC) are the data model standard developed by buildingSMART
Ïnternational to support interoperability in the building Índustry. The ÜFC model specification is
registered by the InternationalStandards Organization (ISO) as ISO 16739-1:2018 and is now
offícially certified. Because of its focus on ease of mteroperability between BD^I software plat-

forms/ some government agencies are requiring IFC format deliverables for publicly funded

building projects.
Some scenarios where IFC exchange may apply and facilitate data exchange mclude, but are

not limited to, the followmg:

• Linking AutoCAD MEP files into a Revit project

• Using Solibri Model Checker or Viewer for model quality audits

• Coordination between Revit projects and Nemetschek Allplan/ Vectorworks/ or ArchÍCAD

• AutoCodes Project by FÍatech

• Construction-Operations Building Information Exchange (COBie) deliverables

• GSA spatial validation
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,yo^an.exportlhe Revít model q"ite effectively to IFC 2x2. TR- 7^ T^ . l

at no cost from any of the followmg websitesF " ^w'1 w PIUërams mat canbe ^

» DDS-CAD Open BIM Viewer from Data Design Systen, (www. dds-cad

• Solibri Model Viewer (www. sol-ibn . com)

• IFCViewer (www.-ifcbrowser.com)

• Tekla BIMsight (www. tekla. com)

FIGURE 7.36

Revit model exported to

IFC format

ge<S^^^^^^r^m^i—""tothepoce.s^^or^3DÍ
fuZeZ^i^t;,rriedjsmtendrf
soZaTe'Z^oggTlStoTCh::^^^^=^^£^^S^:^^^^.^^^

VIEWING THE CONTENTS Op AN ÏVC FORMAT FltE"
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,j- you/ve reviewed the contents of the IFC file, you can link it Ínto a Revit project and

linteg'
Ít Ínto yotu- coordination process as follows:

Start a new project with any default template. From the Insert tab in the ribbon/

dick Unk IFC.

NavigatetothecOT-Structure.-ifcfileanddickOpen.

3. Save the project file.

4. Open the default 3D view and inspect the linked geometry.

Jf an updated IFC file is received/ overwrite thelinked file you used in the previous steps.
the host project file is reopened/ the linked IFC content will be updated.

DOWNLOADING AND CUSTOMIZING THE OPEN SOURCE IFC EXPORTER

In addition to offering a basíc IFC export coimnand in the default mstalÏafion of Revit/ Autodesk
hgs been developmg an improved open source IFC exporter with the development community.

TÍUS exporter is available in the Autodesk App Store (https ://apps.autodesk.com). Search for
ffC 2019. Anyone can download ana mstall the free IFC exporter/ which will seamlessly update
the default Revit IFC exporter. We recommend that you periodicalÏy check to see íf there is a

newer version. As of the time of this writing/ the version of the exporter is listed as IFC

2019 19.2.0.
After you have installed the IFC exporter/ you can still launch the IFC export command from

the File Tab menu (Export > IFC). You will see the same Export IFC dialog box (Figure 7.37), but
it will have updated IFC setups. Much like the CAD export process described earlier m this
chapter/ this interface allows you to create, customize/ and save export setups.

&ORE 7.37
' IFC exportei-

' interface

Project; to (ixport:

g] dB-Sasnple-Eusi

a sOT-SampÍí-Building-Fin

For advanced IFC exporting options/ click the Modify Setup button shown in Figure 7.37.

There are several tabs across the top of the Modify Setup dialog box that allow you to customize

the IFC export sefcup (Figure 7.38). In addition to the piedefined export configurations, you can
create and save your own setups fhat will be maintained in the project file.

An excellent resource for IFC interoperability in Revit is the buildingSMART alliance
web page for Common Building Information Model Files (www. n-i bs .org/?page=bsa^

commonb-i mf-i lês). You can download sample files as well as a configurationlguide with

additional instructions related to customizing IFC exports from Revit.
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FIGURE 7.38

CustomÍzing and saving

IFCexport setups
~-S,tSK.,,Íf^ \ eew»'

•U.iGSACs.iiepiCïsKjnSiy 2{);gï;nipï

.AtídfLï^ Cü^-tü

••r.^ir-Sí.eiACeiçaO,
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CLASSIFYING IFC EXPORT SETTINGS

Because exporting to IFC format is about converting one model format to another, set+ii

not related to layer conversions/ línetypes/ or text as they are in a CAD export. Rather. if-i(

to correctly map the logic of the Revit model organization to the open data standard. In ol

words/ model object categories must be mapped to IFC entities; for example, waüs in Rpv^

be exported as IfcWall entities. This translation seems quite logical for walls and other nhif

but consider an electric receptacle. Such a device would be categorized in Revit as ElectFÍc;

Fixture; however/ it is classified as IfcFlowTerminal in the open standard. Entities are furtí

refmed with types—m this case/ IfcFlowTerminalType—that would help distinguish an ele

receptacle from other IfcFlowTerminal entities such as a faucet or an air diffuser.

The schema ofthe currentíy released standard (IFC4) canbeviewed atwuvw.buUdingsml

tech. org/ the portal for the Model Support Group and Implementa tion

Although IFC4 is the currently released standard/ many workflows still use IPC2x3/ inciudï

na tive export from Revit. If you work wíth IFC export and import regularly in the Revit en^

nnent, you should become familiar with some of the common classifications in the IFC schel

You/ll fínd the IFC2x3 and IFC4 schema indexes here:

https://standards.bu1T.d1ngsmart.org/IFC/RELEASE/IFC2x3/FINAL/HTML/
https://standards.build-ingsmart.org/IFC/RELEASE/IFC4/ADD2_TCl/HTML/

Click Alphabetical Listing and then Entities/ and you will be able to browse through sói
the most common TFC classifications related to building elements. For example/ fínd and cl

IfcCovering/ and you will see that this classifícation is used for wall daddings, flooring, ani|

suspended ceilings.

One aspect of the Revit project model that can be exported to IFC is a structural grid. Th|

datum objects are beneficiai to the coordination process if you are using Solibri Model Cheçj

Viewer or TekÏa BIMsight; however/ they are not exported if you use the default IFC exportj

settings in Revit. Lefs solve that problem with a quick exerdse. You can continue to use thí
c07~Samp'Le-Bui'ld-ing-Start.rvtfile.

l. Proin the File Tab menu/ click Export > Options > IFC Options.

You might need to scroll down the Export menu to see the OptÍons flyout.
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^ the IFC Export Classes dialog box (Figure 7.39), fínd the entry for Grids and set IFC
Class Name to IfcGrid. Vou must manually enter any IFC entities and types into this

dialog box; therefore/ you should always refer to the buildingSMART website for accurate

classificatíons.

l7-39
^tbe^ppmg

£tcateg°"esto

ntitie3'
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3. Click OK to dose the IFC Export Classes dialog box.

You can save the IFC mappings to a text file for use in other projects.

4. From the Application menu/ click Export > IFC and export with the In-Session Setup

selected. If you are not using the custam IFC exporter that we discussed earlier in this

chapter/ simply set the export file type to IFC2x3 and save the file to your computer

or network.

5. Open the IFC file in an application such as Solibri Model Checker or Viewer/ and you will
be able to see the Revit grid lines in the model-only exported format.

There are two other methods to customize the classification mappings for ÏFC. One is to use

subcategories m families. As an example/ a Revit family created for an elevator hás been assigned

to the Generic Models category; however, a subcategory named Elevators was created in the

family (Figure 7.40).
After the elevator family is loaded into a project, the new subcategories can be assigned to an

appropriate IFC classification. Click the Application menu and then click Export > Options > IFC
Options to open the IFC Export Classes dialog box. Locate the Revit category for Generic Models,

and you will also see the Elevators subcategory/ as shown m Figure 7.41. For 1FC Class Name/

enter IfcTransportElement/ and for IFC Type/ enter IfcTransportElementType/ and you will be

ready to export your project with the additional object classiíications.
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FlCURE 7.40

Create subcategories in a
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The Bottom Line

Use imported 2D CAD data. CA r> ^. ^ ,- . .
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anaging Revit Projects

you will take an in-depth look at how to manage Autodesk® Revit® projects

office. We will explain strategies for the processes needed to support your project

d jiscuss how to review your Revít projects and determine the state of pro|ect health. As you

?e through proactive management you will be able to address potential issues before they

problems that require immediate, often costly remediation.

IN THIS CHAPTER, YOU WILL LEARN TO

• Understand how to conduct Revit/BIM adminisfrafíon

• Explaín how your QA/QC process will work

• Undersfand importanf Revít metrics

• Learn to leverage tools within RevÍt fo assíst with management

Understanding the Importance of Managing
Revit Projects
The aufhors of this book collectively have exfensive experíence m the architecture/ engineeríng/

and construcdon (AEC) industry. For a large part of our careers, we have been involved in

utilizing Revit on projects and have delved into the larger building information modeling (BIM)
landscape. We have traveled the globe discussing Revit projects with a wide variety of compa-

nies. We've seen the complete range of companies with Revit practices/ from large to small and

from the best in class to those that have recentíy adopted Revit. We've seen companies that have

become very successful with Revit/ those companies that struggle with Revit, and everything in

between. Regardless of company size/ the organizations that are successful with Revit projects

have/ at a minimum/ one criticai thing in common: they have developed and implemented a

plan, defming what they intend to use Revit for and how to measure their success in domg só.

What^s in a Plan to Manage Revit Projects?
Lefs be clear: the plan to use Revit on a project is not the same as the plan to manage a

Revit project.


